EZ TAPE for DOS and Windows

USER'S MANUAL

IRWIN
Important Information About Your Tape Drive

Please take a minute to fill in the spaces on this page with information about your tape drive. The information requested will help ensure that you receive quick and thorough responses to your technical support, repair, and service needs. This information is also necessary to verify your warranty.

Purchase Date: ____________________________________________

Drive Model Number: _______________________________________

Product ID Number: _________________________________________

Drive Serial Number: _________________________________________

Irwin, EzTape, AccuTrak, and EC/Tape are registered trademarks of Archive Corporation. EzStart is a trademark of Archive Corporation.

MS-DOS is a registered trademark and Windows is a trademark of Microsoft Corporation. Novell and NetWare are registered trademarks of Novell, Inc. IBM PC LAN is a registered trademark of International Business Machines Corporation. LANtastic is a registered trademark of Artisoft, Inc. 10NET is a registered trademark of Digital Communications Associates, Inc.

Except as permitted under the United States Copyright Act of 1976, no part of this publication may be reproduced or distributed in any form or by any means, or stored in a database or retrieval system, without prior written permission of the publisher.

Copyright 1992 by Archive Corporation. All rights reserved.

Document No. 6003518   6/92
Read This Page First!

What You Should Do First

Before you read this manual, follow these steps:

1. **Record important information about your tape drive.** Fill in the spaces on the inside front cover of this manual with the information requested. This way, you'll have the information handy in case you ever need it.

2. **Install your tape drive.** If your computer dealer installed your tape drive for you, skip this step. Otherwise, follow the instructions you received with your tape drive or installation kit.

3. Install your EzTape software. Refer to the *EzTape Getting Started Manual* for instructions.

When you complete these steps, you are ready to install EzTape®.

About This Manual

This manual shows you how to use the features of your EzTape software. We have designed this manual so that you can read it from cover to cover or just reference the information you need.

For More Information

For more information on how to quickly install and use EzTape, refer to the *EzTape Getting Started Manual*. Also, refer to the "Read Me" file that is installed with EzTape.

If you have a problem using EzTape and cannot find a solution in the documentation, call or fax our Technical Support Hotline. The numbers to call are listed on the following page.
**Contacting Technical Support in the U.S. and Canada:**

*Telephone:* (800) 227 6296  
*Fax:* (407) 263 3536  
*BBS:* (407) 263 3502

Hours are 8:30 AM to 8:00 PM EST, Monday through Friday.

**In Europe:**

*Telephone:* (44) 494 473434  
*Fax:* (44) 494 472044  
*BBS:* (44) 494 436302

Hours are 9:00 AM to 6:00 PM U.K. time, Monday through Friday.
# Table of Contents

<table>
<thead>
<tr>
<th>Chapter:</th>
<th>Title:</th>
<th>Page:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>An Introduction to EzTape</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>What This Chapter Contains</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>EzTape's Backup and Restore Features</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Additional Features of EzTape</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>About Data Compression</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>The EzTape Librarian</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Network Support</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Developing a Backup Plan</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Tips for Easier Backups and Restores</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>How You Can Use EzTape to Back up and Restore Files</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>Exploring the EzTape Menu System</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>What This Chapter Contains</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>A Word About Operating Systems</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Using the Screen Examples</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Graphics and Text Modes under DOS</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Starting EzTape</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Starting EzTape for DOS</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Starting EzTape for Windows</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>A Look at the EzTape Window</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Title Bar</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Menu Bar</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Command Ribbon</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Status Bar</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Control Menu Icon</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Minimize and Maximize Icons</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Window Border</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Scroll Bars</td>
<td>10</td>
</tr>
</tbody>
</table>
# Table of Contents

**Chapter:**  
**Title:**  
**Page:**

## 2 Exploring the EzTape Menu System (continued)

- Choosing Commands from the Menus  
  - Selecting a Menu  
  - Choosing a Menu Option  
  - Canceling a Menu  
  - Shortcut Keys  
- Completing a Dialog Box  
  - Option Buttons  
  - Check Boxes  
  - Text Boxes  
  - List Boxes  
  - Drop Down List Boxes  
  - Command Buttons  
- Selecting Files in the Directory Tree Window  
  - Opening a File Window  
  - Selecting Files and Directories  
  - Moving Among Open Windows  
- Getting Help  
  - The Help Menu  
  - EzTape for Windows Help  
  - EzTape for DOS Help  
  - Cross-References  
  - Command Buttons  
- Exiting EzTape  

## 3 The Quick Ways to Back Up and Restore

- What This Chapter Contains  
- What are the Short-Cuts Options?  
- Using the Quick Commands in the Short-Cuts Menu  
  - Backing Up All Files and Backing Up Modified Files  
  - Restoring All Files
## Chapter: 4  **Backing Up Data From Disk**  
*Page: 27*

<table>
<thead>
<tr>
<th>What This Chapter Contains</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backing Up Files</td>
<td>27</td>
</tr>
<tr>
<td>Backup Set Name</td>
<td>28</td>
</tr>
<tr>
<td>Remarks</td>
<td>28</td>
</tr>
<tr>
<td>Password</td>
<td>29</td>
</tr>
<tr>
<td>Overwrite Backup Set</td>
<td>29</td>
</tr>
<tr>
<td>Reset Archive Bits</td>
<td>29</td>
</tr>
<tr>
<td>Verify After Backup</td>
<td>29</td>
</tr>
<tr>
<td>Add to Library</td>
<td>30</td>
</tr>
<tr>
<td>Compression</td>
<td>30</td>
</tr>
<tr>
<td>Encryption</td>
<td>30</td>
</tr>
<tr>
<td>Using the Options Button</td>
<td>31</td>
</tr>
<tr>
<td>The Wait for... Options</td>
<td>31</td>
</tr>
<tr>
<td>Batch Mode Only</td>
<td>32</td>
</tr>
<tr>
<td>Scan Marked Files</td>
<td>33</td>
</tr>
<tr>
<td>Set Unused Before Backup</td>
<td>33</td>
</tr>
<tr>
<td>Logging Messages</td>
<td>34</td>
</tr>
<tr>
<td>After You Make Backup Selections</td>
<td>34</td>
</tr>
</tbody>
</table>

## Chapter: 5  **Restoring Data From Tape**  
*Page: 35*

<table>
<thead>
<tr>
<th>What This Chapter Contains</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restoring Files</td>
<td>35</td>
</tr>
<tr>
<td>Restore to</td>
<td>36</td>
</tr>
<tr>
<td>Restore With Directory Structure</td>
<td>36</td>
</tr>
<tr>
<td>File Overwrite</td>
<td>37</td>
</tr>
<tr>
<td>Network Rights Restore</td>
<td>38</td>
</tr>
<tr>
<td>Using the Options Button</td>
<td>38</td>
</tr>
<tr>
<td>The Wait for... Options</td>
<td>38</td>
</tr>
<tr>
<td>Batch Mode Only</td>
<td>39</td>
</tr>
<tr>
<td>Scan Marked Files</td>
<td>40</td>
</tr>
<tr>
<td>Logging Messages</td>
<td>40</td>
</tr>
<tr>
<td>After You Make Restore Selections</td>
<td>41</td>
</tr>
<tr>
<td>Using the Librarian to Restore Files from Tape</td>
<td>41</td>
</tr>
<tr>
<td>Chapter</td>
<td>Title:</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>6</td>
<td>Marking and Manipulating Files</td>
</tr>
<tr>
<td></td>
<td>What This Chapter Contains</td>
</tr>
<tr>
<td></td>
<td>When to Mark Files</td>
</tr>
<tr>
<td></td>
<td>How to Mark Files</td>
</tr>
<tr>
<td></td>
<td>Marking Files Manually</td>
</tr>
<tr>
<td></td>
<td>Using the Directory Tree Window to Make</td>
</tr>
<tr>
<td></td>
<td>File Selections</td>
</tr>
<tr>
<td></td>
<td>Selecting a Drive, Tape, or Library</td>
</tr>
<tr>
<td></td>
<td>Directory Tree</td>
</tr>
<tr>
<td></td>
<td>Opening a File Window</td>
</tr>
<tr>
<td></td>
<td>Marking Files and Directories</td>
</tr>
<tr>
<td></td>
<td>What the Mark Symbols Mean</td>
</tr>
<tr>
<td></td>
<td>Excluding Files from Backup</td>
</tr>
<tr>
<td></td>
<td>More About Marking</td>
</tr>
<tr>
<td></td>
<td>Unmarking Files and Directories</td>
</tr>
<tr>
<td></td>
<td>Unmarking All Files</td>
</tr>
<tr>
<td></td>
<td>Obtaining Information About Marked Files</td>
</tr>
<tr>
<td></td>
<td>Scanning Marked Files</td>
</tr>
<tr>
<td></td>
<td>Listing Marked Files</td>
</tr>
<tr>
<td></td>
<td>Using the File Management Commands</td>
</tr>
<tr>
<td></td>
<td>Copying Marked Files</td>
</tr>
<tr>
<td></td>
<td>Moving Marked Files</td>
</tr>
<tr>
<td></td>
<td>Deleting Marked Files</td>
</tr>
<tr>
<td></td>
<td>Changing the Attributes of Marked Files</td>
</tr>
<tr>
<td>7</td>
<td>Using Mark Rules</td>
</tr>
<tr>
<td></td>
<td>What This Chapter Contains</td>
</tr>
<tr>
<td></td>
<td>What is a Mark Rule?</td>
</tr>
<tr>
<td></td>
<td>Using the Apply Rule Option</td>
</tr>
<tr>
<td></td>
<td>Searching for Files</td>
</tr>
<tr>
<td></td>
<td>Accessing and Using the Mark Rules Window</td>
</tr>
<tr>
<td></td>
<td>Deleting a Rule</td>
</tr>
<tr>
<td></td>
<td>Adding or Editing a Rule</td>
</tr>
<tr>
<td>Chapter</td>
<td>Title: Creating and Using Parameter Files</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>8</td>
<td>What This Chapter Contains</td>
</tr>
<tr>
<td></td>
<td>What is a Parameter File?</td>
</tr>
<tr>
<td></td>
<td>How to Create a Parameter File</td>
</tr>
<tr>
<td></td>
<td>Creating Parameter Files from the EzTape Menu</td>
</tr>
<tr>
<td></td>
<td>How You Can Use Parameter Files</td>
</tr>
<tr>
<td></td>
<td>Loading a Parameter File in the EzTape Window</td>
</tr>
<tr>
<td></td>
<td>Running a Parameter File from the Command Line</td>
</tr>
<tr>
<td></td>
<td>EzTape for DOS Users</td>
</tr>
<tr>
<td></td>
<td>EzTape for Windows Users</td>
</tr>
<tr>
<td></td>
<td>Adding a Parameter File as a Program Item</td>
</tr>
<tr>
<td></td>
<td>(Windows Users Only)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title: Using the EzStart Program</th>
<th>Page: 69</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>What This Chapter Contains</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>What is EzStart?</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>What Happens When an Operation Begins</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>EzStart for DOS</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>EzStart for Windows</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>Installation Notes</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>EzStart for DOS</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>EzStart for Windows</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>Scheduling Events in the EzStart Window</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Opening the EzStart Window - DOS</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Opening the EzStart Window - Windows</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Adding/Editing an EzStart Event</td>
<td>72</td>
</tr>
<tr>
<td></td>
<td>Command</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Dispatch Time and Date</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Recurring Event</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Announce Event</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>Deleting an EzStart Event</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>Placing an EzStart Event on Hold</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>EzStart's Options Menu</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>Creating a User Defined Interval</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>Setting A Sticky Announcement (Windows only)</td>
<td>76</td>
</tr>
<tr>
<td></td>
<td>If You Missed a Scheduled Event</td>
<td>76</td>
</tr>
<tr>
<td>Chapter</td>
<td>Title: Using the EzTape Tape Librarian</td>
<td>Page: 77</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>What This Chapter Contains</td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>What is the Librarian?</td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>Viewing the Contents of the Library</td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>Setting EzTape to Automatically Update</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>the Librarian</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Label Your Tapes</td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>Using the Librarian to Search for and</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Restore Files</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Searching the Library</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Restoring Files from Tape with the</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Librarian</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The Librarian Menu</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Updating the Library</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Backup Sets</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Displaying Information About a Backup</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>Set from the Library</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Deleting a Backup Set from the Library</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Removing a Tape from the Library</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title: Using the Tape Utilities</th>
<th>Page: 85</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>What This Chapter Contains</td>
<td>85</td>
</tr>
<tr>
<td></td>
<td>The Utilities Menu</td>
<td>85</td>
</tr>
<tr>
<td></td>
<td>Display Tape Info</td>
<td>85</td>
</tr>
<tr>
<td></td>
<td>Name Tape</td>
<td>86</td>
</tr>
<tr>
<td></td>
<td>Set Tape to Unused</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>Backup Sets</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>Getting Information About a Backup Set</td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>Deleting Backup Sets</td>
<td>89</td>
</tr>
<tr>
<td></td>
<td>Retension Tape</td>
<td>89</td>
</tr>
<tr>
<td></td>
<td>Initializing a Tape</td>
<td>89</td>
</tr>
<tr>
<td></td>
<td>Using Preformatted Tapes</td>
<td>89</td>
</tr>
<tr>
<td></td>
<td>Reusing Tapes</td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>Using the Initialization Option</td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>Ejecting a Tape</td>
<td>90</td>
</tr>
<tr>
<td>Chapter</td>
<td>Title:</td>
<td>Page:</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>12</td>
<td>Manipulating Windows</td>
<td>91</td>
</tr>
<tr>
<td></td>
<td>What This Chapter Contains</td>
<td>91</td>
</tr>
<tr>
<td></td>
<td>Determining the Order of Files in a File Window</td>
<td>91</td>
</tr>
<tr>
<td></td>
<td>Stacking, Tiling, and Cascading Windows</td>
<td>92</td>
</tr>
<tr>
<td></td>
<td>Arranging Window Icons</td>
<td>92</td>
</tr>
<tr>
<td></td>
<td>Refreshing Your Window Display</td>
<td>92</td>
</tr>
<tr>
<td></td>
<td>Closing All Directory Windows</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Automatically Replacing File Windows</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Opening/Closing Windows</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>The Directory Tree Window</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>The Mark Rules Window</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Hiding and Showing the Command Ribbon</td>
<td>94</td>
</tr>
<tr>
<td></td>
<td>Hiding and Showing the Status Bar</td>
<td>94</td>
</tr>
<tr>
<td></td>
<td>Using the Open Windows List</td>
<td>94</td>
</tr>
<tr>
<td></td>
<td>Printing with EzTape</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Using the Printer Setup Window</td>
<td>96</td>
</tr>
<tr>
<td>13</td>
<td>Setting the Default Options</td>
<td>97</td>
</tr>
<tr>
<td></td>
<td>What This Chapter Contains</td>
<td>97</td>
</tr>
<tr>
<td></td>
<td>Setting Window Defaults</td>
<td>97</td>
</tr>
<tr>
<td></td>
<td>Setting Backup Defaults</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Setting Restore Defaults</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Setting Organize Defaults</td>
<td>101</td>
</tr>
<tr>
<td>A</td>
<td>Using EzTape on a Network</td>
<td>103</td>
</tr>
<tr>
<td>B</td>
<td>Troubleshooting</td>
<td>111</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>121</td>
</tr>
</tbody>
</table>
An Introduction to EzTape

What This Chapter Contains

This chapter shows you how you can get the most from your EzTape® software. Read this chapter to get information on:

- the features that EzTape provides
- how to develop a backup plan
- how you can use EzTape

EzTape's Backup and Restore Features

EzTape software is the program you use to operate your tape drive with your computer. EzTape allows you to:

- **backup** data from your computer's hard disk(s) and network drives. You can select the specific files, directories, and disks that you want to back up. You can also choose to back up only data that has been created or modified since your last backup.

- **restore** data from tape to disk. You can select the specific files and directories that you want to restore.

- create and use **parameter files**, which are files that contain the information needed to run customized backups and restores.

- use the **EzStart®** program to schedule automatic, unattended backups and restores, as well as other events which you determine.

You can use EzTape's backup and restore features to:

- guard against loss of data. By regularly backing up the data that resides on your computer's hard disk, you will be protected in case of hard disk failure.
• archive data on tape for future use. This also frees up space on your hard disk.

• back up data from one computer and restore it on another computer. Using tape is a convenient way to transport data between computers.

**Additional Features of EzTape**

Here are some additional features which EzTape provides for you:

• **command ribbon** allows you to execute common commands by using simple buttons, rather than using menu commands

• **quick backup or restore** by using the Short-Cuts menu

• **data compression** to increase the amount of data you can store on tape

• the ability to back up and restore data from **multiple hard disk drives** in a single operation

• a **Librarian** option, which allows you to store the directory information from your EzTape backup tapes onto your hard disk. You can use this information to locate specific files on your tapes.

• **network support** for most popular networks

**About Data Compression**

Data compression reduces file size during backup so you can store more data on tape. When you restore compressed files, they are automatically decompressed to return to their original sizes.

EzTape offers three levels of data compression so that you can choose the best combination of system performance and compression ratio. The different levels are described in chapter 4, *Backing Up Data From Disk*. 
The EzTape Librarian

EzTape includes an integrated Librarian feature, allowing you to use your hard disk to store and manage directory information from tapes that you use with EzTape. Refer to chapter 10 for instructions on how to use the Librarian.

Network Support

EzTape also provides network support for most popular networks. Refer to appendix A for information on how to use EzTape to provide network backup.

Developing a Backup Plan

In order to more fully protect your system from permanent loss of data, you should develop a backup plan and use it to make regular backups. For example, you can develop your backup plan based on how often you use your computer system and which files you update most frequently.

A simple, effective backup plan might involve these steps:

1. Once a week, make a backup of your entire hard disk.
2. Each subsequent day in the week, back up those files you have modified or created.
3. Begin the next week's backup on a new tape. You may want to archive the previous week's backup permanently, or just save it for a few weeks.

If you plan on reusing tapes, we suggest that you use a tape rotation scheme. For example, you might:

- place week 1's backups on tape 1
- place week 2's backups on tape 2
- place week 3's backups on tape 3
- reuse tape 1 and place week 4's backups on tape 1
- reuse tape 2 and place week 5's backups on tape 2

and so on.
**Tips for Easier Backups and Restores**

To make backing up, restoring, and archiving data easier, we suggest that you do the following:

- Keep extra tapes available during backup in case the size of a particular backup is larger than a single tape's available capacity.

- Label each tape with the date, the tape's contents, and the tape ID number shown on the Display tape info screen.

**How You Can Use EzTape to Back Up and Restore Files**

Because it is so full-featured, there are a number of different ways you can use EzTape to back up and restore files:

<table>
<thead>
<tr>
<th>To perform:</th>
<th>You can use:</th>
<th>Refer to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>quick, simple backup and restore functions</td>
<td>the Short-Cuts menu</td>
<td>chapter 3</td>
</tr>
<tr>
<td>specialized backup and restore functions</td>
<td>EzTape's powerful windowing system</td>
<td>chapters 4 and 5</td>
</tr>
<tr>
<td>backup and restore functions from selections you have saved</td>
<td>parameter files</td>
<td>chapter 8</td>
</tr>
<tr>
<td>automated program initiation, including backup and restore, even when you are away from your computer</td>
<td>the EzStart program</td>
<td>chapter 9</td>
</tr>
</tbody>
</table>
Exploring the EzTape Menu System

What This Chapter Contains

This chapter provides:

• guidelines for using this manual with your operating system
• instructions for starting and exiting EzTape
• a brief description of the EzTape main window
• instructions for using menu commands, dialog boxes, and the directory tree and file windows
• guidelines for using EzTape help

A Word About Operating Systems

EzTape is available for several different operating system environments. This manual describes EzTape features that are common to the DOS and Windows environments. For specific instructions on setting up EzTape for use with your operating system, refer to the Getting Started manual.

Using the Screen Examples

Throughout this manual you will find screens examples that are used to illustrate EzTape's features. Most of these screens are taken from EzTape for Windows. If you have EzTape for DOS, you will notice a slight difference in the appearance of your screens, but the features are identical.
The figure below shows a sample EzTape screen in both environments:

**EzTape for DOS**

![EzTape for DOS Diagram]

**EzTape for Windows**

![EzTape for Windows Diagram]

**Graphics and Text Modes under DOS**

The EzTape for DOS screen shown above is displayed in graphics mode. This mode, available if you have an EGA or VGA monitor, uses special characters to give the screen a more attractive appearance.

If you have a CGA or monochrome monitor, your screen will appear in text mode, using text characters to draw the screen display.

You may change the display mode by selecting an option in the **Window defaults** dialog box, as described in chapter 13.
Starting EzTape

To start EzTape, use the appropriate procedure for your operating system as outlined below.

Starting EzTape for DOS

1. Go to the DOS prompt and type:

   ```
   EZTAPE
   ```

   If EzTape is not in your system's path statement, do this from the EzTape directory.

2. You will see the EzTape startup screen. Select the OK button, and you will be in EzTape.

Starting EzTape for Windows

1. Start Windows.

2. Double click the EzTape icon from the Program Manager.

   ▶ Note: If you did not choose to add EzTape to a group during installation, you will need to use the Program Manager’s Run command to start EzTape. See your Windows documentation for details.

3. You will see the EzTape startup screen. Select the OK button, and you will be in EzTape.
A Look at the EzTape Window

The figure below shows the parts of the EzTape software main window:

**Title Bar**

This bar displays the title EzTape and the version number at the top of the window. You can move the EzTape window by grabbing the title bar with your mouse.

**Menu Bar**

The menu bar is the part of the window that contains the names of the pull-down menus you can use.

**Command Ribbon**

The command ribbon provides a means for you to perform commonly-used operations with simple pushbuttons. You must have a mouse to select commands from the ribbon.
Status Bar

The status bar provides a readout which displays the current status of your tape operation.

Control Menu Icon

When you click on this icon (or press the [Alt] and [Spacebar] keys simultaneously), you see the Control Menu. Every EzTape window has a Control Menu. It contains the following commands for manipulating the window:

<table>
<thead>
<tr>
<th>Command</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore</td>
<td>Restores the window to its former size after it has been maximized or minimized.</td>
</tr>
<tr>
<td>Move</td>
<td>Allows you to use the keyboard to move the window to another location on the desktop.</td>
</tr>
<tr>
<td>Size</td>
<td>Allows you to use the keyboard to change the size of the window.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Shrinks the window to an icon.</td>
</tr>
<tr>
<td>Maximize</td>
<td>Enlarges the window to its full size.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the window.</td>
</tr>
<tr>
<td>Switch To</td>
<td>(Windows environment only) Brings up the Windows task list.</td>
</tr>
<tr>
<td>Next</td>
<td>(Directory Tree and File windows only) Switches to the next open window.</td>
</tr>
<tr>
<td>Split</td>
<td>(File windows only) Allows you to use the keyboard to move a window's split bar.</td>
</tr>
</tbody>
</table>
Chapter 2  Exploring the EzTape Menu System

Minimize and Maximize Buttons

You can click on these buttons with your mouse to:

• minimize the window to an icon, or

• maximize the window to fill the screen

Window Border

You can use the window border to resize the window by clicking and holding on it with your left mouse button, then dragging the border to the place you want it to be.

Scroll Bars

The scroll bar allows you to see text that doesn't fit in the window. If you have a mouse, you can drag the scroll box to the part of the window you wish to see. Or, click the scroll arrows to move up and down in the window one line at a time.

If you are using the keyboard, press the up or down arrow key that points in the direction you want to go. You can also use the \[PgUp\] and \[PgDn\] keys to scroll up and down one page at a time.

Choosing Commands from the Menus

EzTape's pull-down menus contain commands that are grouped according to function. For example, the Tree menu contains commands for displaying the directory tree.

Selecting a Menu

To select a menu, you can either:

• Click on the name of the menu you wish to see.

• Press \[Alt\] or \[F10\] to access the menu bar. Type the underlined letter in the name of the menu you want, or use the right and left arrows to select the menu name, then press \[Enter\].
Choosing a Menu Option

To choose an option in the menu, you can either:

- Click the option you want in the menu.
- Type the underlined letter in the name of the option you want, or use the up and down arrow keys to select the option, then press [Enter].

Some menu options contain features that tell you more about the option:

<table>
<thead>
<tr>
<th>Feature</th>
<th>What it means:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grayed out</td>
<td>The option is not available at this time.</td>
</tr>
<tr>
<td>Ellipsis</td>
<td>Selecting this option calls up a dialog box where you will be asked to enter more information.</td>
</tr>
<tr>
<td>Check mark</td>
<td>The option is in effect. Check marks are used to toggle between menu options.</td>
</tr>
</tbody>
</table>

Canceling a Menu

You can close the menu at any time by pressing [Esc] or by clicking anywhere outside the menu.

Shortcut Keys

Many EzTape menu options have key combinations assigned to them. These are called shortcut keys because they allow you to select a command without entering the menu. If a menu option has a shortcut key, you will see it displayed to the right of the option on the pull-down menu.
Chapter 2

Exploring the EzTape Menu System

The figure below shows an example of shortcut keys assigned to the options in the Tree menu:

<table>
<thead>
<tr>
<th>Tree</th>
<th>Ctrl+D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk</td>
<td></td>
</tr>
<tr>
<td>Library</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Tape</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Expand one level +</td>
<td></td>
</tr>
<tr>
<td>Expand branch *</td>
<td></td>
</tr>
<tr>
<td>Collapse branch -</td>
<td></td>
</tr>
</tbody>
</table>

Completing a Dialog Box

EzTape displays a dialog box when it needs more information to carry out a command. You select options or type in text to complete the missing information. The figure below shows a typical dialog box:

If you are using a mouse, simply click the boxes to select the options you want.

If you are using the keyboard, press [Tab] to move forward from one group of options to the next. To move backwards, press [Shift] [Tab]. Within a group of options, use the arrow keys to move through the list.
EzTape uses the following conventions to indicate when an option is selected:

- In EzTape for Windows, the dotted rectangle box, called the selection cursor, marks the selected option.

- In EzTape for DOS, the highlight bar marks the selected option.

The following sections describe the items you will find in a dialog box.

Option Buttons

Use these buttons to select an option from a group. First, tab to the group, then use the up and down arrow keys to select the option you want and press [Enter]. If you are using a mouse, just click the option you want. Note that you can only select one option from the group.

Check Boxes

Use these boxes to turn options on and off. An option is selected if it contains an X. You can check more than one box in a group. To select a check box, tab to the group, cursor to the item you want, then press the [Spacebar] key to enter an X. Press [Spacebar] again to clear the selection. If you are using a mouse, click on the check box to enter an X; click again to clear the selection.

Text Boxes

Use these boxes to enter text, such as a file name. To enter information in a text box, tab to the box and start typing at the text insertion point. (You can use the arrow keys to change the position of the insertion point.) Or, you can click on the text already in the box and start editing.

List Boxes

List boxes display a list of options to choose from. To select an option in a list box, tab to the box, use the up and down arrow keys to select the option you want, then press [Enter].
Drop Down List Boxes

Some text boxes may contain a drop down list box. In these cases, a default response is displayed in the text box, but you can see additional responses by accessing the drop down list. Press [F4] or click the arrow to the right of the box to view these options. You select an option from the drop down list just as you would with a list box.

Command Buttons

Command buttons initiate an action. Most dialog boxes contain at least two command buttons: Cancel and OK. Select Cancel to abandon the dialog box and the menu option that prompted it. Select OK to accept the responses in the dialog box and proceed.

Sometimes you will see a command button that contains an ellipsis. For example, Options... The ellipsis means that choosing this command button will bring up another dialog box.

To choose a command button, tab to it and press [Enter], or simply click it.

Selecting Files in the Directory Tree Window

From the main window, you can access two other types of windows: the Directory Tree and File windows. These are the windows where you select files for backup or restore.

The directory tree shows the directories of the current drive or backup set. You will learn how to change the directory display in chapter 6.

A file window appears when you open a directory in the directory tree. This window lists the subdirectories and files in that directory.
The figure below shows both of these windows:

EzTape uses a selection cursor to indicate the currently selected file or directory in these windows:

- In EzTape for Windows, a dotted rectangle box marks the current item.
- In EzTape for DOS, a caret (↑) appears next to the current item.

**Opening A File Window**

To open a file window for a directory:

- Double-click on the directory.

or

- Use the up and down arrow keys to position the cursor over the directory you want to open, then press [Enter].
Selecting Files and Directories

You select files by highlighting them with your mouse or keyboard commands.

To select files or directories with a mouse:

- Click the item you wish to select.
- To select multiple items, hold down the mouse button and drag the highlight bar over the items you wish to select.

To select files or directories with the keyboard:

- Use the up and down arrow keys to position the cursor at the item you wish to select.
- To select multiple items, hold down the [Shift] key, then use the up or down arrow keys to highlight the range you wish to select.

Note: In EzTape for Windows versions 3.1 or earlier, the selection cursor moves independent of the highlight bar. To select files or directories with the keyboard, you must first move the selection cursor over the item you want, then press [Spacebar].

EzTape offers the following additional keyboard commands to make file selection easier:

<table>
<thead>
<tr>
<th>To:</th>
<th>Press:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll the selection cursor up one page</td>
<td>[PgUp]</td>
</tr>
<tr>
<td>Scroll the selection cursor down one page</td>
<td>[PgDn]</td>
</tr>
<tr>
<td>Move the selection cursor to the first item in the window</td>
<td>[Home]</td>
</tr>
<tr>
<td>Move the selection cursor to the last item in the window</td>
<td>[End]</td>
</tr>
<tr>
<td>Select the current item plus all items in the page above it</td>
<td>[Shift] [PgUp]</td>
</tr>
<tr>
<td>To:</td>
<td>Press:</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Select the current item plus all items in the page below it</td>
<td>[Shift] [PgDn]</td>
</tr>
<tr>
<td>Select the current item plus all items above it</td>
<td>[Shift] [Home]</td>
</tr>
<tr>
<td>Select the current item plus all items below it</td>
<td>[Shift] [End]</td>
</tr>
<tr>
<td>Make non contiguous selections (select items that aren't in a range)</td>
<td>[Ctrl] + key-strokes</td>
</tr>
<tr>
<td>Select all items in the window</td>
<td>[Ctrl] [/]</td>
</tr>
<tr>
<td>Cancel the current selection</td>
<td>[Ctrl] [Spacebar]</td>
</tr>
<tr>
<td>Cancel all selections</td>
<td>[Ctrl] []</td>
</tr>
</tbody>
</table>

**Moving Among Open Windows**

While you may have many windows open, you may only work in one window at a time. The currently selected window is called the **active** window. It usually appears at the front of the desktop, and its title bar has a different color to distinguish it from the other open windows.

The easiest way to make a window active is to click anywhere in the window with a mouse.

If you are using a keyboard, follow these steps to make a window active:

1. Press [Alt] [Spacebar] to open the control menu of the current active window.
2. Type [T] to choose the **Next** command.
3. Repeat these steps until you're at window you want.

You may type [Ctrl] [F6] as a shortcut for steps 1 and 2.
Another way to make a window active is to select it from the list at bottom of EzTape's **Window** menu.

You can return to the Directory Tree window from an active window by pressing **[Esc]**. *Exception: This feature was not implemented in EzTape for Windows versions 3.1 or earlier.*

### Getting Help

You can access EzTape's on-line help at any time while you are in the EzTape program. Use one of the following methods to access the help screens in EzTape:

- Press **[F1]** to get context sensitive help for any menu or menu option you highlight or for any active dialog box.
- Use the **Help** menu to get information about a specific topic.

### The Help Menu

EzTape's **Help** menu contains the following options for obtaining information about EzTape:

<table>
<thead>
<tr>
<th>Use this option:</th>
<th>To obtain:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>an index of help topics</td>
</tr>
<tr>
<td>Keyboard</td>
<td>a description of every keyboard command that can be used with EzTape</td>
</tr>
<tr>
<td>Commands</td>
<td>help for EzTape menu commands</td>
</tr>
<tr>
<td>Procedures</td>
<td>help for specific EzTape topics</td>
</tr>
<tr>
<td>Using Help</td>
<td>help for using the help options</td>
</tr>
<tr>
<td>About...</td>
<td>the EzTape startup information screen</td>
</tr>
</tbody>
</table>
EzTape for Windows Help

EzTape for Windows follows standard Windows conventions for on-line help. If you need more information about using help, you can:

- Select Using Help from the Help menu.
- Consult your Windows documentation.

EzTape for DOS Help

This section describes on-line help specifically for EzTape for DOS.

Whenever you access help, whether by selecting an option from the Help menu or pressing [F1], you will receive a screen similar to the one below:

The following subsections describe the features of the EzTape for DOS help screen.
Cross-References

Cross-references are words or phrases that allow you to "jump" to another help topic. A cross-reference is indicated by highlighted text.

To jump to a cross-referenced topic, you can either:

- Double click the cross-referenced text.
- Press [Tab] until you have selected the cross-reference you want, then press [Enter]. Press [Shift] [Tab] to move backwards on the screen.

In general, there are two types of cross-references that appear in EzTape for DOS help: definitions and related topics.

When a word or phrase in the help topic appears highlighted, that means it has a definition associated with it. Use your mouse or keyboard to jump to a brief definition of the word or phrase. To return to your original topic, select the Back command button, described in the next subsection.

The related topics listed at the end of the topic are a convenient way for you to jump to other topics that are related to the one you just viewed.

Command Buttons

EzTape help contains the following command buttons to assist you in finding the help topics you need:

<table>
<thead>
<tr>
<th>Command button</th>
<th>What it does:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Displays an index of all EzTape help topics.</td>
</tr>
<tr>
<td>Next</td>
<td>Displays the next topic in a sequence. Use this button to browse through related topics.</td>
</tr>
<tr>
<td>Previous</td>
<td>Displays the previous topic in a sequence. Use this button to browse through related topics.</td>
</tr>
<tr>
<td>Back</td>
<td>Displays the last topic you viewed.</td>
</tr>
</tbody>
</table>
**Command button:**  **What it does:**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Lists keywords for the help topics. When you select a keyword, you will see a list of topics that contain that keyword. You can then select a topic to display from the list.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the current help screen. (Make sure that your printer is turned on before choosing this command.)</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Help window and returns you to EzTape.</td>
</tr>
</tbody>
</table>

To select a command button, press the [Alt] key plus the underlined letter in the command you wish to use. Or, you can just click the command button.

**Exiting EzTape**

There are two ways that you can exit EzTape:

- Select **Exit** from the **File** menu.
- Select **Close** from the EzTape **Control Menu**.

When you choose these commands, you will end your EzTape session and return to the system.
What This Chapter Contains

This chapter provides a description of the Short-Cuts options which you can use to perform quick backups and restores.

*Note:* Before you begin, insert the tape cartridge that you are restoring from or backing up to.

What are the Short-Cuts Options?

The Short-Cuts command provides the following quick command options:

- back up all files on a particular disk drive
- back up only the files on a disk drive that have been added or modified since last backup
- restore all backup sets from a tape
Using the Quick Commands in the Short-Cuts Menu

To access the Short-Cuts menu, use the following procedure:

1. Enter EzTape using the guidelines in chapter 2.

2. Choose the Short-Cuts option from the File menu. You will see the Short-Cuts menu:

   The Short-Cuts menu has the three quick command buttons. When you want to exit the menu, you can choose the Main Menu button to return to the EzTape main menu or the Exit Program button to exit out of the EzTape software.
Backing Up All Files and Backing Up Modified Files

The **Backup All Files on Disk** option will make a complete backup of each of the drives that you select. The **Backup Modified Files on Disk** option will back up only those files which have been added or changed since last backup. The files for each drive you back up will be stored on the tape in a group called a **backup set**. A backup set is the group of files stored on the tape during a single backup session.

When you select one of these options, you receive the following window:

![Disk Drives Window]

When you are through selecting the drive(s) to back up, select the **OK** option. The backup will begin.

If you run out of room on your tape during the backup operation, EzTape will prompt you to continue the backup on a second tape. Insert tapes as needed until the backup is complete.
Restoring All Files

The **Restore Current Tape** option restores everything from the tape in the backup drive, except hidden and system files. If your tape contains backup sets from more than one drive, this option will restore the files to the drives from which they came, in the order in which you created them.

The **Restore Current Tape** option restores multiple-tape backups; that is, if your backup spans two tapes, this option will prompt you for the second tape once it has restored the first tape.

When you select this option, the restore will begin.
What This Chapter Contains

This chapter shows you how to back up data from a hard disk drive to tape.

Backing Up Files

Note: Insert the tape cartridge before you begin to back up data.

To back up selected files from disk to tape, you must:

1. Indicate that you will select files from disk for backup by either:
   • clicking the Disk button in the command ribbon
   • selecting Disk from under the Tree menu

   A list of the hard drives on your system appears in the Directory Tree window. If a directory icon has:
   • a "+" sign, it contains subdirectories. Click on the directory icon to display the list of subdirectories.
   • a "-" sign, it is currently displaying its subdirectories. Click on it again to hide the subdirectories.
   • no sign, it does not contain any subdirectories.

2. Highlight the directories or files you want to back up. Then, use the Mark button in the command ribbon or the Mark selected files option in the Mark menu to mark the selected directories and files. A black circle appear next to each directory and file you selected.
For more detailed information on selecting and marking files, refer to chapter 6, *Marking and Manipulating Files*.

3. Select the **Backup** button from the command ribbon or select the **Start Backup** option from the **Tasks** menu. You see the **Backup set parameters** window:

![Backup set parameters window](image)

If you selected files from multiple drives, you will receive this window for every drive selected. EzTape makes a separate backup set for each drive.

The following sections show you how to use the options in the Backup set parameters window. You can set default values for some of these parameters. For more information on setting defaults, see chapter 13.

**Backup Set Name**

This is the name of the backup set that will be stored on tape. Enter a name of up to 31 alphanumeric characters in length. If you create more than one backup set with the same name on a tape, EzTape will automatically append a sequential number to the name.

**Remarks**

You may optionally enter any comments you may have concerning the contents of this backup set for future reference. These remarks can be up to 127 characters long. You can read these comments from the Backup Set Info screen, as described in chapter 11.
Password

You may optionally assign a password to the backup set if you want to prevent access to it by other users. You may choose a password of up to 15 alphanumeric characters. The password is case-sensitive, so the password topsecret is not the same as TOPSECRET.

Overwrite Backup Set

You can select a backup set from this list to overwrite. This will destroy the old backup set. This option is not available if you are using a streaming tape drive (such as the Irwin 7000 and 9000 Series drives and the Irwin model A850).

Reset Archive Bits

If you select this option, EzTape will back up all selected files, then check the archive bits for these files. If the archive bit for a file was on, it will turn the bit off. If the bit is in the off position, this lets the operating system and EzTape know that the file has been backed up. If you later change the file, the operating system will turn the archive bit back on.

When you back up files using the Backup Modified Files on Disk option, EzTape will back up only those files with the archive bit on.

Verify After Backup

If you select this option, EzTape will perform a byte-by-byte comparison between the backed-up tape data and the hard disk data once the backup is complete. This function is optional since EzTape ensures data integrity during backup with its patented EC/Tape error correction method. If you are using a streaming tape drive (such as the Irwin 7000 and 9000 Series drives and the Irwin model A850), this option will be grayed out because on such devices, read after write eliminates the need for a separate verify.

Performing a verify will approximately double the time required for the backup.
Add to Library

If you select this option, EzTape will automatically add this backup set to the Library when it is completed. For more information on the Librarian, refer to chapter 10.

Compression

Select the level of data compression for the backup. If you choose to use data compression, your files will be reduced during backup so that they take up less room on the tape. When you restore the compressed files, they will automatically decompress to return to their original sizes.

There are three levels of data compression:

• Level 0 provides no data compression.

• Level 1 provides data compression of approximately 1.2:1 (files compress to 80% of original size).

• Level 2 provides data compression of approximately 2:1 (files compress to 50% of original size).

For most systems, using Level 1 compression will result in an improved backup time. You may want to experiment with your system to see how using Level 2 compression affects performance. In some cases, using Level 2 compression may result in longer backup times. In general, we recommend that you use Level 2 compression when you want to increase capacity, not as a way to improve backup time.

Some files can be compressed more than others. For example, text and graphics files usually compress more than executable files. If EzTape encounters files that have been compressed by other application software, no further compression occurs.

Encryption

Select the encryption option if you want the backup set to be encoded until it is restored to its original form. This option is useful for security purposes.
When you select the **Encryption** box, a window will appear asking for an encryption key of 6 to 16 characters. Enter the encryption key and select **OK**. **Remember the encryption key**; you will need it to restore your data. The key is case-sensitive. **Without the key, there is no way to restore the data**—even we will not be able to recover it.

**Using the Options Button**

When you select the **Options** button in the backup window, you see the following window:

![Backup Options Window](image)

These options apply to the entire backup session. This means that you may have only one set of backup options for all backup sets created. If you select different options for each backup set, EzTape will use the last set selected.

**The Wait for... Options**

Use these options to specify when EzTape should pause during an operation to hold a message on the screen. For example, if you checked the **Critical Errors** box and a critical error occurs, EzTape will pause the current operation and display the appropriate error message on the screen.
The following table describes the wait options:

<table>
<thead>
<tr>
<th>This error type:</th>
<th>Includes errors:</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Sharing Errors</td>
<td>that occur when EzTape attempts to access files that are in use by another application</td>
</tr>
<tr>
<td>Critical Errors</td>
<td>that prevent the current backup or restore operation from completing</td>
</tr>
<tr>
<td>Non-Critical Errors</td>
<td>from which EzTape can recover and continue</td>
</tr>
</tbody>
</table>

You may select any combination of these choices.

All error messages will appear in the Message Log after the operation completes, whether or not EzTape pauses to display them. For more information on error messages, refer to appendix B.

**Batch Mode Only**

The following options apply only when EzTape is operating in batch mode. EzTape operates in batch mode when you execute a parameter file.

The following table describes the two batch mode options:

<table>
<thead>
<tr>
<th>This option:</th>
<th>Tells EzTape:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split Backup Set</td>
<td>to pause if it encounters a split backup set, allowing you to insert the additional tape. In most cases, you will want to set this option. If you don't, EzTape will stop after backing up to the first tape.</td>
</tr>
<tr>
<td>Operation Completed</td>
<td>to pause for confirmation once the operation is finished. If you do not choose this option, the default is to exit the program upon completion.</td>
</tr>
</tbody>
</table>
Scan Marked Files

Choosing the Scan Marked Files option enables the following information to be displayed during the backup:

- a time line showing to show you the status of the backup
- the total number of bytes and files you backing up
- the percentage of the backup that is complete

If you check this box, EzTape will automatically scan the marked files before the backup begins. You will see a window similar to one below:

<table>
<thead>
<tr>
<th>Scan Marked Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drives: 1</td>
</tr>
<tr>
<td>Directories: 6</td>
</tr>
<tr>
<td>Files: 133</td>
</tr>
<tr>
<td>Total bytes: 6,304,396</td>
</tr>
</tbody>
</table>

Set Unused Before Backup

The option allows you to re-use a tape. If selected, for an Irwin AccuTrak Series drive (except the A850), EzTape will set the tape to unused before the backup begins. For Irwin streaming tape drives (A850, 7000 Series, and 9000 Series), EzTape will erase the tape.

Caution: Before using this option, make sure that the tape does not contain information that you want to save.
Chapter 4

Backing Up Data From Disk

Logging Messages

If you select the Log messages and... box, messages in the error log will be saved and the following options are enabled.

If you select the Excluded file list option, EzTape will append a list of files that were excluded from the backup set (due to sharing violations, etc.). If you select the Included file list option, EzTape will append a list of files that were included in the backup set.

In the Log File Name field, enter a name for the log file.

After You Make Backup Selections

Once you make selections, click the OK button. You will see the Backup Status window:
Restoring Data From Tape

What This Chapter Contains

This chapter shows you how to restore data from tape to a hard disk drive.

Restoring Files

Note: Insert the tape cartridge that you are restoring from before you begin to restore data.

To restore selected files from tape to disk, you must:

1. Indicate that you will select files from tape for restore by either:
   - clicking the Tape button in the command ribbon
   - selecting Tape from under the Tree menu

   A list of the backup sets on your installed tape appears in the Directory Tree window. If a backup set or directory icon has:
   - a "+" sign, it contains subdirectories. Click on the directory icon to display the list of subdirectories.
   - a "-" sign, it is currently displaying its subdirectories. Click on it again to hide the subdirectories.
   - no sign, it does not contain any subdirectories.

2. Highlight the directories or files you want to restore. Then, use the Mark button in the command ribbon or the Mark selected files option in the Mark menu to mark the selected directories and files. You will see a black circle appear next to each directory and file you selected.
For more detailed information on selecting and marking files, refer to chapter 6, *Marking and Manipulating Files*.

3. Select the **Restore** button from the command ribbon or select the **Start Restore** option from the **Tasks** menu. You will see the **Restore parameters** window:

![Restore parameters window](image)

If you selected files from more than one backup set, you will receive this window for each backup set selected.

The following sections show you how to use the options in the Restore parameters window. You can set default values for some of these parameters. For more information on setting defaults, see chapter 13.

**Restore to**

This field must contain the directory path where you want the data restored. When the window opens, this field will contain the directory path for the original source drive of the backup set (for example, C:\). If you want to restore the data to another location, enter the new directory path in this field (for example, C:\TEMP).

**Restore with Directory Structure**

Select this option if you want the data to be restored in its original directory structure. If you don't select this option, all files will be stored at the same directory level.
For example, let’s say you are restoring a file named TEST in the REPORTS directory. You are restoring to the directory path C:\. If you choose this option, then TEST will be restored in the REPORTS directory. If you don’t select this option, TEST will be restored directly into the root directory C:\. The figure below shows a graphic depiction of this example:

![Diagram showing file overwrite options]

**File Overwrite**

These options allow you to specify if you want EzTape to write over a newer hard disk file with an older file from the backup tape. Usually, you will want to retain the newer version of the file. Choose the appropriate option from the following table:

<table>
<thead>
<tr>
<th>If you:</th>
<th>Select this option:</th>
</tr>
</thead>
<tbody>
<tr>
<td>never want a newer file on your hard disk</td>
<td>Do not overwrite newer files</td>
</tr>
<tr>
<td>disk overwritten by a file from the tape</td>
<td></td>
</tr>
<tr>
<td>want to be prompted for verification before EzTape</td>
<td>Prompt if newer file exists</td>
</tr>
<tr>
<td>overwrite a newer hard disk file</td>
<td></td>
</tr>
<tr>
<td>want EzTape to write over newer files without</td>
<td>Restore all selected files</td>
</tr>
<tr>
<td>informing you</td>
<td></td>
</tr>
</tbody>
</table>
Network Rights Restore

If you are restoring Novell network files, the restore window provides three options for retaining trustee rights:

- do not restore any rights
- restore target directory rights only
- restore rights to all directories in the target path

For more information on using Novell network trustee rights, refer to appendix A.

Using the Options Button

When you select the Options button in the restore window, you see the following window:

These options apply to the entire restore session. This means that you may have only one set of restore options for all backup sets restored. If you select different options for each backup set, EzTape will use the last set selected.

The Wait for... Options

You use these options to specify when EzTape should pause during an operation to hold a message on the screen. For example, if you checked the Critical Errors box and a critical error occurs, EzTape will pause
the current operation and display the appropriate error message on the screen. The following table describes the Wait options:

<table>
<thead>
<tr>
<th>This error type:</th>
<th>Includes errors:</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Sharing Errors</td>
<td>that occur when EzTape attempts to access files that are in use by another application</td>
</tr>
<tr>
<td>Critical Errors</td>
<td>that prevent the operation from completing</td>
</tr>
<tr>
<td>Non-Critical Errors</td>
<td>from which EzTape can recover and continue operation</td>
</tr>
</tbody>
</table>

You may select any combination of these choices. All error messages will appear in the Message Log after the operation completes, whether or not EzTape pauses to display them (you must have logging enabled). For more information on error messages, refer to the Appendix B.

**Batch Mode Only**

The following options apply only when EzTape is operating in batch mode. EzTape operates in batch mode when you execute a parameter file.

The following table describes the two batch mode options.

<table>
<thead>
<tr>
<th>This option:</th>
<th>Tells EzTape:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split Backup Set</td>
<td>to pause if it encounters a split backup set, allowing you to insert the additional tape. If most cases, you will want to set this option. If you don't, EzTape will stop after restoring the first tape.</td>
</tr>
<tr>
<td>Operation Completed</td>
<td>to pause for confirmation once the operation is finished. If you do not choose this option, the default is to exit the program upon completion.</td>
</tr>
</tbody>
</table>
Scan Marked Files

Choosing the Scan Marked Files option enables the following information to be displayed during the restore:

• a time line to show you the status of the restore

• the total number of bytes and files you are restoring

• the percentage of the restore that is complete

If you check this box, EzTape will automatically scan the marked files before the restore begins. You will see a window similar to the one below:

Logging Messages

If you select the Log messages and... box, messages in the error log will be saved. This option also enables the other options in the Log box.

If you select the Excluded file list option, a list of files that were not restored (due to sharing violations, etc.) will be appended to the log.

If you select the Included file list option, a list of files that were restored will be appended to the log.

In the Log File Name field, enter a name for the log file.
After You Make Restore Selections

Once you have made selections, click the OK button. You will see the Restore Status window, which provides information on the status of the restore:

If you are restoring data that spans two or more tapes, EzTape will prompt you when it is time to insert a new tape.

Using the Librarian to Restore Files from Tape

You can also restore files by marking them in the tape library. The library contains backup set information about the tapes you've used with EzTape. For more information about the Librarian feature, refer to chapter 10.

The Librarian allows you to restore files and backup sets from multiple tapes. You can also use the Librarian to select files from a split backup set. Once you start the restore, EzTape will prompt you to insert the correct tapes as needed.
Marking File Selections

What This Chapter Contains

This chapter provides the following information:

- when you need to mark files
- how to mark and unmark files using the Directory Tree window
- how to obtain helpful information about your marked files
- how to copy, move, delete, and change attributes for marked files

When to Mark Files

In EzTape, you designate files for a task, such as backup or restore, by marking them. For example, you will mark files when you want to specify:

- directories or files that you want to back up from your hard disk to tape
- directories or files that you want to restore from tape to your hard disk
- directories or files on your hard disk that you want to copy, move, change, or delete
- files to search for on a hard disk, on a tape, or in the Librarian
How to Mark Files

There are two ways to mark files:

- manually, through the directory tree window
- using the Apply Rule option as described in chapter 7

Marking Files Manually

Marking files manually involves two steps: highlighting your selections, then marking them. This method allows you to select a combination of drives, directories or individual files for an EzTape task. It's important to remember that highlighting a file is not the same as marking it.

Using the Directory Tree Window to Make File Selections

You use the Directory Tree window to highlight the drive, directory or individual files you wish to mark. The Directory Tree window is normally present when you start up EzTape. If you have closed the Directory Tree window and would like to open it again, select Show directory tree from under the Window menu.

The following sections show you how to:

- list the directories or backup sets for a hard disk, library, or backup tape
- use the Directory Tree window to display and mark directories or backup sets
- use a file window to display and mark the contents of a directory or backup set
Selecting a Drive, Tape, or Library Directory Tree

Before you can mark or unmark selections, you must first choose the media type that you want to select files from: a hard disk, the EzTape library, or the tape installed in your tape drive. (When you first start EzTape, the directory tree displays your hard disk volume.)

To select a media type, you can either:

- Click the Disk, Library, or Tape buttons in the command ribbon, shown below:

- Select Disk, Library, or Tape from under the Tree menu.

Once you select a media type, the appropriate directory tree will appear in the Directory Tree window. If you selected:

- Disk, you see a list of hard drives on your system
- Library, you see a list of backup sets in your library
- Tape, you see a list of backup sets on your installed tape
The figure below shows a directory tree displaying the contents of a hard drive:

If your directory or backup set has:

- a "+" sign, it contains subdirectories. Click on the backup set or hard disk directory to display this list of subdirectories.
- a "-" sign, it is currently displaying its subdirectories. Click on it again to hide the subdirectories.
- no sign, it does not contain any subdirectories

You can also display or hide directory tree information by using the following choices from under the Tree menu:

- **Expand one level** expands a directory to its first level of subdirectories
- **Expand branch** expands a directory to show all levels of subdirectories
- **Collapse branch** hides all levels of subdirectories in the selected directory
Opening a File Window

When you open a directory, you see a file window for that directory. This window lists the subdirectories and files in that directory.

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Modify Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACKUP.BMP</td>
<td>766</td>
<td>07/22/91 15:59</td>
</tr>
<tr>
<td>BACKUP.ICO</td>
<td>766</td>
<td>06/19/91 16:23</td>
</tr>
<tr>
<td>DISK.BMP</td>
<td>986</td>
<td>04/08/91 14:46</td>
</tr>
<tr>
<td>FLDRMINS.BMP</td>
<td>274</td>
<td>04/09/91 13:24</td>
</tr>
<tr>
<td>FLDRPLUS.BMP</td>
<td>274</td>
<td>04/09/91 14:24</td>
</tr>
<tr>
<td>FOLDER.BMP</td>
<td>274</td>
<td>03/26/91 17:08</td>
</tr>
<tr>
<td>LIB.BMP</td>
<td>886</td>
<td>04/08/91 15:33</td>
</tr>
<tr>
<td>MARK.BMP</td>
<td>766</td>
<td>07/22/91 15:58</td>
</tr>
<tr>
<td>MARK.ICO</td>
<td>766</td>
<td>05/22/91 09:45</td>
</tr>
<tr>
<td>RESTORE.BMP</td>
<td>766</td>
<td>07/22/91 16:00</td>
</tr>
<tr>
<td>RESTORE.ICO</td>
<td>766</td>
<td>06/19/91 16:34</td>
</tr>
<tr>
<td>SCAN.BMP</td>
<td>766</td>
<td>07/22/91 16:01</td>
</tr>
</tbody>
</table>

Marking Files and Directories

To mark files or directories, highlight the items you wish to mark with your mouse or keyboard. Then, use the Mark button in the command ribbon or the Mark selected files option in the Mark menu to mark the selected directories and files. A black circle will appear by the file or directory you selected. (In text mode, this mark appears as black rectangle.)

What the Mark Symbols Mean

When you mark a directory, all subdirectories and files in that directory are also marked. If you mark a directory that does not contain any files, a black circle (or rectangle) still appears by that directory to indicate it was marked. This is useful when you are using parameter files (chapter 8). The mark indicates that the parameter file will back up any files that may one day appear in that directory.
In the figure below, the backup set "Drive G" is marked, so all of its subdirectories are marked as well.

When you mark a file or subdirectory within a directory, a half circle appears by the parent directory to show that part of its contents may be marked. (In text mode, this mark appears as a black dot.) If you mark a subdirectory that does not contain any files, a half circle (or dot) still appears by that directory to indicate that there is a mark rule which applies to it.

If you want to make sure that a marked directory contains files, use the Scan marked files or List marked files options, described later in this chapter.

**Excluding Files from Backup**

You may notice that some files are marked with a circle with an X in the middle. (In text mode, this mark appears as a plain X.) These files are system files, or files currently in use, that EzTape has excluded from all backups.

The names of excluded files are contained in the file EXCLUDE.CFG. If you want to add a file to this list, you can edit EXCLUDE.CFG using a text editor.
More About Marking

You can only mark files from one directory tree at a time. For example, if you mark files on the hard disk, then move to the tape and try to mark files, EzTape will ask you if you want to clear the existing marks on the hard disk.

The Library directory tree allows you to mark files from multiple tapes for restoring. This directory tree is useful when you want to mark selected files from a split backup set. When you restore from the Library, EzTape will prompt you to insert the appropriate tapes as they are needed. For more information on using the EzTape Librarian, refer to chapter 10.

Unmarking Files and Directories

To unmark files or directories, highlight the items you wish to unmark with your mouse or keyboard. Then, use the Unmark button in the command ribbon or the Unmark selected files option in the Mark menu to unmark the selected files and/or directories. The black circles (or rectangles) by the selected files or directories will disappear.

If you unmark all files and subdirectories within a directory, a half circle (or dot) still appears by the directory to indicate a mark rule has been applied. To remove the mark from a directory, you must select that directory and use the Unmark selected files option. When you unmark a directory, all files and subdirectories in that directory are also unmarked.

Unmarking All Files

If you want to unmark all the files that are currently marked, select the Clear all marks option from the Mark menu. You will receive a window asking you to verify. If you select the Yes option, all marks will be cleared. If you select No, the marked files will remain marked.
Obtaining Information About Marked Files

Before you backup or restore your marked files, you can:

- scan the marked files for information
- list the marked files

The following sections describe these two options.

Scanning Marked Files

You can scan the currently marked files for the following information:

- the total number of drives, directories, and files that are marked for backup or restore
- the total number of bytes for all your marked files

You can use this information to help verify that there is enough room on your disk or tape for all the marked files. Scanning marked files before a backup or restore activates the time line, bytes and files completed, and percentage completed displays in the Status window for the operation.

To scan the marked files, use the Scan button in the command ribbon or select the Scan marked files option in the Tasks menu. You will see the Scan Marked Files window:

```
Scan Marked Files

Drives: 1
Directories: 6
Files: 133
Total bytes: 6,304,396

OK
```
Note: In multi-tasking systems, the disk contents may change between the time you scan a drive and the time the backup is completed. Therefore, the scanned and final totals may not match exactly.

Listing Marked Files

You can access a list of all marked files, including their directory path, size, date they were last modified, and attribute flags. You can use this information to help verify that you’ve selected the correct files for backup.

When you select the List marked files option from the Tasks menu, EzTape will scan the currently marked files. When EzTape is done scanning, you see the Marked File List window:

![Marked File List window]

Using the File Management Commands

EzTape's File menu offers four commands for managing files on your hard disk. Once you have marked files, you can copy, move, delete or change their attributes from within EzTape.
You use the Copy marked files option in the File menu to copy the currently marked files to another directory or drive. When you select this option, you will see the Copy Files dialog box:

<table>
<thead>
<tr>
<th>Option:</th>
<th>Choose this option to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keep tree</td>
<td>copy the directory tree structure along with the file. For example, if you are copying the file C:\EZTAPE\PFILES\BACK.TPF to D:\ and you select this option, the file will be copied to D:\EZTAPE\PFILES\BACK.TPF. If you do not select this option, it will be copied to D:\BACK.TPF.</td>
</tr>
<tr>
<td>Confirm each file</td>
<td>receive a request for confirmation for every file you are copying. The confirmation will provide options for skipping the file, continuing the copy operation, and canceling the copy operation.</td>
</tr>
<tr>
<td>Confirm on error</td>
<td>receive a message if an error occurs. You will have the option to continue the operation or cancel the operation.</td>
</tr>
<tr>
<td>Destination path</td>
<td>determine the directory path where you want to copy the files to.</td>
</tr>
</tbody>
</table>
Moving Marked Files

You use the **Move marked files** option in the **File** menu to move the files you have marked to another directory or drive. When you select this option from the file menu, you see the **Move Files** dialog box:

![Move Files dialog box]

The table below describes the options you can choose in this dialog box:

<table>
<thead>
<tr>
<th>Option:</th>
<th>Choose this option to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keep tree</td>
<td>move the directory tree structure along with the file.</td>
</tr>
<tr>
<td></td>
<td>For example, if you are moving the file</td>
</tr>
<tr>
<td></td>
<td>C:\EZTAPE\PFILES\BACK.TPF to D:\ and you select this option, the file will be moved to</td>
</tr>
<tr>
<td></td>
<td>D:\EZTAPE\PFILES\BACK.TPF. If you do not select this option, it will be moved to D:\BACK.TPF.</td>
</tr>
<tr>
<td>Confirm each file</td>
<td>receive a request for confirmation for every file you are moving. The confirmation will provide options for skipping the file, continuing the move operation, and canceling the move operation.</td>
</tr>
<tr>
<td>Confirm on error</td>
<td>receive a message if an error occurs. You will have the option to continue the operation or cancel the operation.</td>
</tr>
<tr>
<td>Remove empty directories</td>
<td>remove any marked directories that are empty after the move operation.</td>
</tr>
<tr>
<td>Destination path</td>
<td>determine the directory path where you want to move the files to.</td>
</tr>
</tbody>
</table>
Note that when you use the Move marked files option and the source and target directories are on the same drive, EzTape does not have to copy the data - it simply moves the directory entry.

Deleting Marked Files

You use the Delete marked files option in the File menu to delete the files you have marked. When you select this option from the file menu, you see the Delete Files dialog box:

The table below describes the options you can choose in this dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Choose this option to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm each file</td>
<td>receive a request for confirmation for every file you are deleting. The confirmation will provide options for skipping the file, continuing the delete operation, and canceling the delete operation.</td>
</tr>
<tr>
<td>Confirm on error</td>
<td>receive a message if an error occurs. You will have the option of continuing or canceling the operation.</td>
</tr>
<tr>
<td>Remove empty directories</td>
<td>remove any marked directories that are empty after the delete operation.</td>
</tr>
</tbody>
</table>
Changing the Attributes of Marked Files

You use the Change marked files option in the File menu to change the attributes of the files you have marked. When you select this option from the file menu, you see the Change File Attributes dialog box:

![Change File Attributes dialog box]

The table below describes the options you can choose in this dialog box:

<table>
<thead>
<tr>
<th>Option:</th>
<th>Choose this option to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm each file</td>
<td>receive a request for confirmation for every file you are changing. The confirmation will provide options for skipping the file, continuing the change operation, and canceling the operation.</td>
</tr>
<tr>
<td>Confirm on error</td>
<td>receive a message if an error occurs. You will have the option of continuing or canceling the operation.</td>
</tr>
<tr>
<td>Attributes</td>
<td>set the hidden, system, read only, and archive attributes of the files you marked. If you select On, the attribute is turned on for all your marked files. Off will set the attribute off and ignore will keep the current setting.</td>
</tr>
</tbody>
</table>
What This Chapter Contains

This chapter shows you:

• what a mark rule is

• how to use the Apply Rule option

• how to use the Mark Rules window

What is a Mark Rule?

A mark rule consists of a path specification which represents one or more of the files you have marked. Whenever you mark files, a rule or rules is created. For example, if you mark the directory TEST in the root directory of hard drive C:, the following rule would be created:

```
C:\TEST\*.*
```

This rule indicates that all files in the directory TEST on C: drive have been marked.

You can view mark rules by selecting Show mark rules from the Window menu.
Using the Apply Rule Option

The Apply rules option lets you apply a rule to the directories and files you have selected. To use the apply rule option, select the files and directories from your Directory Tree window. Then, select the Apply rule option from the Mark menu.

You will see the Apply Rule dialog box:

![Apply Rule dialog box]

The following table describes each option in the Apply Rule dialog box as well as those in the Edit Rule and Add Rule dialog boxes, which are discussed later in this chapter.
<table>
<thead>
<tr>
<th><strong>For this option:</strong></th>
<th><strong>Enter:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mask</strong></td>
<td>The rule you want to apply. For example, if you want EzTape to mark only those files from those you selected that end in the extension &quot;.EXE&quot;, enter &quot;.EXE&quot; in this field.</td>
</tr>
<tr>
<td><strong>Include subdirectories</strong></td>
<td>If you check this box, EzTape will also apply the rule to subdirectories of the directories you selected.</td>
</tr>
<tr>
<td><strong>Modified only</strong></td>
<td>If you check this box, EzTape will apply the rule only to files that have been created or modified since last backup.</td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td>Choose whether you want this rule to mark or unmark the files it applies to.</td>
</tr>
<tr>
<td><strong>Attributes</strong></td>
<td>Select the file types you want this applied to. The default is to apply it to all files.</td>
</tr>
<tr>
<td><strong>Date/Time</strong></td>
<td>The default for the Apply Rule dialog box is to apply to all files, regardless of time and date. If you select a date or time in this option, put it in the following format:</td>
</tr>
<tr>
<td><strong>Date:</strong></td>
<td>01-21-91</td>
</tr>
<tr>
<td><strong>Time:</strong></td>
<td>15:53 (equals 3:53 PM)</td>
</tr>
</tbody>
</table>

When you add a rule using this dialog box, the new rule appears in the **Mark Rules** window.
Searching for Files

You can also use the **Apply Rules** option to search for files on the hard disk, on a tape, or in the tape Librarian. For example, to search for all files with an .EXE extension on drive C, you must:

- select all files on drive C
- apply the rule *.EXE

All files with the .EXE extension will be marked. You can select the **List marked files** option from the **Tasks** menu to view these files in the **Marked File List** window.

Accessing and Using the Mark Rules Window

To access the **Mark Rules** window, select the **Show mark rules** option in the **Window** menu. You see the following window:
A rule may be preceded by one or more of the symbols in the following table.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Indicates:</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;</td>
<td>in place of the drive designator, this symbol means that the rule applies to all drives or backup sets</td>
</tr>
<tr>
<td>-</td>
<td>this rule unmarks files</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Deleting a Rule**

To delete a rule, highlight the rule in the Mark Rules window and select the **Delete** button. The rule will disappear. The files affected by the deleted rule will revert back to their former state. For example, if you use a rule to unmark a certain file and then delete the rule, the file will once again be marked.

**Adding or Editing a Rule**

To edit a rule, highlight the rule you want to edit and select the **Edit** button. To add a rule, select the **Add** button. If you select either of these buttons, you will see a dialog box asking for rule information:
The options in these dialog boxes are the same as those shown for the **Apply Rule** dialog box. The only difference is how you use the **Mask** field. In the **Add Rule** or **Edit Rule** dialog box, you must specify the drive or backup set to which the rule will apply.

For example, enter:

```
D:\*.DOC
```

to apply the rule to all .DOC files on the D drive.

Enter:

```
WEEKLY\*. *
```

to apply the rule to all files in the WEEKLY backup set.
What This Chapter Contains

This chapter shows you:

• what a parameter file is

• how to create a parameter file

• how you can use parameter files

In this chapter, we assume that you are already familiar with how to use the Backup Parameters window (chapter 4) and the Restore Parameters window (chapter 5).

What is a Parameter File?

A parameter file is a file where you save your file selections so you can repeat a specific EzTape task. You can create parameter files for tasks that you perform on a regular basis. This allows you to perform these tasks without having to configure EzTape each time.

For example, if you wanted to back up a specific set of files on a regular basis, you could create a parameter file. This parameter file would allow you to perform the backup without having to select the files, mark them, and choose backup set parameters each time.
Chapter 8

Creating and Using Parameter Files

How to Create a Parameter File

EzTape offers two ways to create a parameter file:

- Use the EzTape menu to create backup and restore parameter files only.

- For advanced users, set up a parameter file using a text editor and EzTape’s parameter file format. With this method you can set up parameter files for any EzTape task, including backup, restore, Short-cuts commands, tape initialization or any other tape utility. The parameter file format is described in the “Read Me” file that was installed with EzTape.

Creating Parameter Files from the EzTape Menu

The EzTape menu provides options for creating backup and restore parameter files. Follow this procedure to create a parameter file:

1. Mark the files or backup sets that you want to backup or restore.

2. Select the Save parameter file option in the File menu. If you marked files on a hard drive, you see the Backup Parameters window. If you marked backup sets on a tape (or the library), you see the Restore Parameters window.

3. Fill in the boxes for the options you want, then select OK. The Save parameter file window will appear:

   ![Save Parameter File Window]

   - **Directory**: c:\eztape
   - **File name**: Enter a file name
   - **Directories**: Choose directories

4. Enter a file name, then select OK. EzTape will save your parameter file with a .TPF extension.
How You Can Use Parameter Files

EzTape allows you to use parameter files:

- within EzTape, for backup and restore parameter files only
- from the command line
- to perform automatic operations. Refer to chapter 9, *Using the EzStart Program* for information about this procedure.

Loading a Parameter File in the EzTape Window

When you load a backup or restore parameter file in the EzTape window, EzTape will mark the files as specified. Use the following procedure to load a parameter file.

1. Select the Load parameter file option from the File menu. If you currently have files marked, you will be asked if you want to clear those marks. If you answer Yes, the marks will be discarded. If you answer No, the marks from the parameter file will be added to those you have already made.

You will see the following dialog box:

2. Select the directory of the parameter file that you want to load. You will see a list of the parameter files in that directory. Select the parameter file you want to load.
When you select a parameter file, you may receive a message asking if you want to clear current marks. This message indicates one of the following:

- you did not clear the current marked files when you were prompted earlier in this procedure
- there are marks on a different device type than those in the parameter file

For example, if your parameter file marks files on a hard drive and you currently have files marked on a tape, you must clear the marks on the tape or the parameter file can't be loaded.

When you have selected a parameter file, EzTape will load it. The files specified in the parameter file will be marked. You may mark additional files or remove marks from your selections.

3. Select **Start a backup** or **Start a restore** from the **Tasks** menu. (These commands are also available on the ribbon.) The **Backup Parameters** or **Restore Parameters** window will appear, depending on which task you selected. This window contains the options you chose for the parameter file when you set it up. You may change these options or accept them as is.

4. Select **OK** to begin the backup or restore.

**Running a Parameter File from the Command Line**

EzTape allows you to execute a parameter file without entering the EzTape menu, through the command line.

**EzTape for DOS Users**

To execute a parameter file:

Type the following information at the DOS prompt:

```
EZTAPE [parameter filename] [Enter]
```
**EzTape for Windows Users**

To execute a parameter file:

1. Select **Run** from Program Manager's **File** menu

2. Enter the following information in the **Command line** box:
   
   \texttt{EZTAPEW [parameter filename]}

3. Select **OK**.

In both **DOS** and **Windows**, if your path statement does not include the EzTape program directory, you must also include the full path name of the directory where you installed EzTape.

EzTape assumes that your parameter files end with `.TPF`. If you used a different extension, make sure to include this extension when you type in the filename.

For example, if you want to run a parameter file named `BACKUPC.TPF`, you would type:

\texttt{EZTAPE BACKUPC} \hspace{1cm} (DOS)

or

\texttt{EZTAPEW BACKUPC} \hspace{1cm} (Windows)

---

**Adding a Parameter File as a Program Item (Windows Users Only)**

In you are running Windows, you can set up a parameter file as a program item in a group window. For example, you could add a parameter file to the EzTape group. That way, you can execute the parameter file simply by clicking its icon.

For more information on adding program items to a group window, refer to your operating system documentation.
What This Chapter Contains

This chapter describes the EzStart program and shows you how to use the EzStart window to set up EzStart events.

What is EzStart?

EzStart is a special program which allows you to schedule events to run automatically while you are away from the computer. An event might be a parameter file you’ve created, or a DOS or Windows command.

Once you create a schedule of automatic operations, EzStart will monitor your system's date and time and perform the events on schedule. Your computer must be turned on with EzStart loaded for the program to operate.

What Happens When an Operation Begins

EzStart for DOS

In the DOS environment, you must be at the DOS prompt for EzStart to execute a scheduled event. If your computer system is busy at the time an event is scheduled to run, EzStart will beep to let you know that it's ready and will postpone the event. EzStart will check every 60 seconds after the scheduled time to see if the system is free.

EzStart for Windows

In Window's multi-tasking environment, EzStart simply begins the event when scheduled, even if you are using other applications at the time.
Installation Notes

If you selected Add EzStart during the installation process, EzStart will load automatically every time you start your system. If you did not select this option, follow the procedures below to load EzStart.

EzStart for DOS

EzStart for DOS actually consists of two program:

- EZTIMER is a memory-resident program which monitors your system for scheduled events and launches them at the appointed time.

- EZSTART provides the window where you set up events.

In order for EzStart to work, EZTIMER must be loaded into memory. To set this to occur automatically, add the following line to your AUTOEXEC.BAT file:

```
C:\EZTAPE\EZTIMER  -r
```

(If you installed EzTape in some other directory, substitute that directory name for EZTAPE in the path.)

Otherwise, you must type EZTIMER -r at a time before your event scheduled to begin for EzStart to run the event.

You can remove the EzStart timer from memory at any time without restarting the computer by typing EZTIMER -u.

EzStart for Windows

In the Windows environment, EzStart is a separate application called EZSTARTW. To set EzStart to load automatically, add the following line to your WIN.INI file:

```
load=c:\eztape\ezstartw
```

(If you installed EzTape in some other directory, you should substitute that directory name for eztape in the path.)
Note: If you have Windows version 3.1 or later, you can simply copy the EzStart program item from the EzTape group to the Windows Startup group.

You may also load EzStart by using Program Manager’s Run command. Make sure to start the EzStart program before your event is scheduled to begin.

Scheduling Events in the EzStart Window

Use the EzStart window to set events to run automatically and view events you have already scheduled.

Opening the EzStart Window - DOS

To open the EzStart for DOS window, type:

```
EZSTART [Enter]
```

If the EzTape program directory is not in your path, you must include the full path name of the directory where EzTape is installed.

You will see the EzStart window, similar to one for the Windows environment, shown below.

Opening the EzStart Window - Windows

To view the EzStart window in under Windows, maximize the EzStart icon at the bottom of the desktop. You will see the EzStart window:
The EzStart window provides the following information:

- The upper portion of the screen displays the event that is scheduled to occur next.

- The lower portion of the screen lists the events you've scheduled to run. Start dates are listed at the left. You will see the letter “O” or “R” to the left of the event. An “O” indicates that the event will occur one time only. An “R” indicates that it is set to recur.

The following sections describe how to use the four option buttons: **Edit**, **Add**, **Delete**, and **Suspend**.

**Adding/Editing an EzStart Event**

To add an event to the EzStart schedule list, select the **Add** button. To edit an event in the EzStart schedule list, highlight the event you want to edit and select the **Edit** button.

When you select the **Add** or **Edit** button, you see the **EzStart Event Schedule** window:

Fill in these fields as instructed in the following sections. When you are through entering the information into this window, select the **OK** button. You will return to the **EzStart** window and the event will appear in the event list.

If you do not want this event entered into the EzStart schedule, select the **Cancel** button to return to the **EzStart** window.
Command

Use the **Command** field to select the parameter file you wish to execute. Open the Command drop-down list box and choose a parameter file from the list displayed.

You can also use the Command field to launch any DOS or Windows application. You must include the full path name for the file you wish to execute.

Dispatch Time and Date

Enter the **time**, using a 24-hour clock, at which you want the automatic operation to begin. For example, enter 08:00 for 8:00 AM and 20:00 for 8:00 PM. You can enter times from 00:00 to 23:59.

Enter the **date** on which you first want the automatic operation to begin. In the U.S., use the format month/day/year; in Europe, use the format day/month/year. For example, you would enter the date July 8, 1993 as 7/8/93 (U.S.) or 8/7/93 (Europe).

Recurring Event

Check this option if you want the event to recur over time. When you select this option, the **Recurring Frequency** buttons which were grayed out become available at the bottom of the window. Use these buttons to indicate how frequently the event should occur. Once you make your selection, the entry in the **Date** box may change to reflect your new choice.

If you select the **Weekly** button, you must also choose the day or days of the week that the event will occur. Use the second row buttons for this purpose.

The last button in the top row is a **spin** button. Use the up and down arrows on this button to see additional frequency options.

One of these options is **User defined interval**. This option selects a recurring interval you specify through the EzStart menu. For more information on this option, see *Creating a User Defined Interval*, later in this chapter.
**Announce Event**

Check this option if you want EzStart to make an announcement before launching an event. Under **DOS**, EzStart beeps to let you know an event is due to begin. This gives you the opportunity to exit your current application and return to the DOS prompt in time for the event to launch successfully. Under **Windows**, EzStart displays a message on the screen announcing when the event will occur.

When you select this option, the **Pre Dispatch Announcement** buttons will appear at the bottom of the EzStart Event Schedule window. Use these buttons to indicate how soon before an event the announcement should be made. If you have Ezstart for Windows, you can choose a combination of buttons to set announcements to occur at different times before the event.

The EzStart for Windows menu contains an option that allows you to choose the type of message EzStart will display. This option is discussed in **Setting a Sticky Announcement**, later in this chapter.

**Deleting an EzStart Event**

To delete an event from the EzStart schedule list, highlight the event you want to delete and select the **Delete** button.

**Placing an EzStart Event on Hold**

From time to time you may have events that you want to remove temporarily from the schedule but not delete. EzStart allows you to place these events on hold.

To place an event on hold:

1. Highlight the event you want to place on hold.
2. Select the **Suspend** button at the bottom of the EzStart window.

The words “ON HOLD” will appear in parenthesis after the event.
To take the event off hold:

1. Highlight the event that is on hold.

2. Select the Suspend button.

The words “ON HOLD” will disappear. If the event missed a scheduled date, EzStart will give you the opportunity to run the event when you take it off hold.

**EzStart's Options Menu**

EzStart's Options menu lets you set a specific repeat interval for a recurring event and change the EzStart for Windows announcement message.

**Creating a User Defined Interval**

Select User Interval from the EzStart Options menu to specify your own repeat interval for recurring operations. This option sets the interval to be used when you select the User defined interval button in the EzStart Event Schedule. Once you select this option, you will see the User Defined Dispatch Interval window:

![User Defined Dispatch Interval Window]

Fill in the fields in this window to indicate the number of days, hours, and minutes you want to wait between operation launches. Click on the OK button to save your interval settings.
Setting a Sticky Announcement (Windows only)

When EzStart for Windows announces an event, it posts a message indicating how long until the event is due to occur. This is called a “sticky” announcement because the message stays on the screen until the event is dispatched or you choose one of the command buttons in the message window.

The figure below shows an example of a sticky announcement:

If you don't want the event to occur as scheduled, you have two options:

- Select the Suspend button to place the event on hold.
- Select the Delay button to postpone the event for two minutes.

You can disable the sticky announce option by selecting Sticky Announce from the Options menu. EzStart will still announce your event, but the message will appear for 15 seconds only.

If You Missed a Scheduled Event

If EzStart isn't loaded when an event is scheduled to occur, the event will not execute as planned. However, if you load EzStart within five minutes of the appointed time for the missed event, EzStart automatically launches the event as scheduled.

If you have EzStart for Windows, the program gives you the opportunity to run any missed events when you load it the next time.

After an event has occurred, EzStart changes its status to “DISPATCHED” but keeps it in the window in case you want to schedule it to run again.
What This Chapter Contains

This chapter shows you how to:

• create a Library of backup set information
• use the Librarian to search for and restore files from tape
• use the Librarian menu options

What is the Librarian?

You use the Librarian to store and manage directory information for your EzTape backup tapes. With the Librarian, you can form an organized tape library so that you can quickly and easily retrieve information.

Every time you update a tape into the library, the Librarian creates a directory of backup sets and files contained on that tape. It stores this information on your hard disk, in a directory called \LIB. This directory is located inside the directory where you installed EzTape, as its subdirectory.

Viewing the Contents of the Library

To access the Library, you can either:

• click the Library button in the command ribbon
• select Library from the Tree menu
The list of the backup sets stored in the Library will appear in the **Directory Tree** window:

![Diagram of Directory Tree](image)

The Library's directory tree contains the following items:

- A list of all of the **backup sets** with directory information recorded in the Library.

- Each backup set shows the eight character **tape ID number** of the tape on which it is stored.

- Individual **directories** that may be expanded or collapsed as described in the previous chapters. You may open these directories to see a list of its subdirectories and files.

### Setting EzTape to Automatically Update the Librarian

The Library is only useful as long as you keep it current. You can set up EzTape to automatically update the Librarian whenever you make a backup file. The information for the backup set you create will be added to the Library.
When you select **Backup Defaults** under the **Options** menu, you see the following window:

![Backup Defaults Window]

Select the **Add to Library** box so that the default is to update the library each time you do a backup. When you do a backup, this option should be marked in the **Backup Parameters** window. You may also want to include this option when you back up using a parameter file.

If you do not select the **Add to Library** box, EzTape will not update the library when you make the backup. It is possible for you to use the Librarian to update the library at a later time, but it is most convenient to use the auto-update feature so that entries are created in the library as backups are performed.

**Label Your Tapes**

The Librarian will assign a serial number to each tape you use.

**Note:** Be sure to label your tapes to reflect these numbers. That way, you will be able to locate the tapes you need.

You can check a tape number by using the **Display Tape Info** option under the **Utilities** menu.
Using the Librarian to Search for and Restore Files

You can use the Library to locate a specific file on tape, then restore it. Say, for example, you backed up a file several months ago and have since forgotten which tape you recorded it on. If you know the name of the file, or some other identifier, you can locate the file and restore it without leaving the Library.

Searching the Library

To locate a file in the Library:

1. Click the Library button in the command ribbon or select the Library option in the Tree menu to access the Library Directory Tree.

2. Highlight the backup sets that you want searched.

3. Select the Apply Rule option from the Mark menu. The Apply Rule dialog box will appear.

4. Use the options in the Apply Rule dialog box to set the criteria for your search. Refer to chapter 7, Using Mark Rules, for a description of the options in this dialog box.

5. Select OK. EzTape will mark the files that meet the rule you’ve set up.

You can select the List marked files option from the Tasks menu to view these files in the Mark File List window.

Restoring Files from Tape with the Librarian

Once you’ve located your files, you can restore them right from the Library. Simply mark the backup sets or files and start the restore just as you would if you were restoring from tape (chapter 5). If you used the Apply Rule option to search for your files, they are already marked.

The Librarian allows you to restore files from multiple tapes. You can also use the Librarian to restore files from a split tape. When you restore from the Library, EzTape will prompt you to insert the correct tapes as they are needed.
The Librarian Menu

The Librarian menu includes the following options:

- Update library
- Backup sets
- Remove tapes

The following sections describe these options.

Updating the Library

You use the Update library option to add a tape's backup set information to the Librarian. If you have already set automatic updating for your Librarian (as described earlier in this chapter), the library will be updated automatically whenever a backup is performed. You need to use this option if:

- the automatic update option is not set
- you need to add backup sets that have not been previously added to your Library

Once you select this option, the Librarian will read the directory information on the tape and check this against the existing library. If there are any differences, EzTape will remove backup sets from the library that no longer exist on the tape and then add to the library those that were created since the last library update.

Backup Sets

You use the Backup Sets option to call up the Library Backup Set List window. You can use this window to:

- display information about a particular backup set
- delete backup set information from the library
The following shows an example of the **Library Backup Set List** window:

![Library Backup Set List window]

To exit this window, click the **Continue** button. The following sections describe the **Info** and **Delete** buttons.

**Displaying Information About a Backup Set**

To display information about a backup set, highlight the backup set name in the **Library Backup Set List** window and select the **Info** button. You will see a Backup set information window similar to the one below:

![Backup Set Info window]
The Backup Set Info window contains the following information about your backup set:

- backup set name
- the date and time that the backup set was made
- the Tape ID number assigned by the Librarian
- the remarks you entered at the time of the backup
- the size of the backup
- the compressed size of the backup (if you don't use compression, this size will be the same as the backup set size)
- the compression ratio (if you didn't use data compression, the ratio will be 1.0 to 1)
- the source drive
- backup type (DOS, OS/2 FAT, OS/2 HPFS, etc...)
- the backup set piece (if the backup is contained on one tape, this number will be 1 and Backup Continued will be grayed out)

This screen will also tell you if the backup set:

- is password protected
- uses data compression
- is encrypted

If a feature is grayed out, then the backup set does not use this feature.
Deleting a Backup Set from the Library

To delete a backup set, highlight the backup set name in the Library Backup Set List window and select the Delete button.

You will be receive a dialog box asking, “Are you sure you want to delete this selection?” If you are sure you want to delete the backup set from the library, select the OK button. Otherwise, select the Cancel button.

Removing a Tape from the Library

The Remove Tapes option allows you to remove all of a tape's backup set records from the library. When you select this option, you see the following window:

To exit this window, click on the Continue option.

To remove a tape from the Library, highlight the tape ID you want to remove in the Library Tape List window. When you select the Remove button, you will see a prompt asking you to verify. If you are sure you want to remove the selected tape from the library, select the OK button. Otherwise, select the Cancel button.
What This Chapter Contains

This chapter shows you how to use the options in the Utilities menu to perform general tape utility functions.

The Utilities Menu

The Utilities menu provides you with the following tape options:

- Display tape info
- Name tape
- Set tape to unused
- Backup sets
- Retension tape
- Initialize tape
- Eject tape

The following sections describe these options.

Display Tape Info

Select this option to display information about the tape currently installed in your tape drive. This option does not display the contents of the tape; to see the contents of the tape, use the Directory Tree window as described in chapter 6.
Here is an example of a **Display Tape Info** window:

<table>
<thead>
<tr>
<th>Tape Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tape name:</strong></td>
</tr>
<tr>
<td><strong>Tape number:</strong></td>
</tr>
<tr>
<td><strong>Formatted:</strong></td>
</tr>
<tr>
<td><strong>Tape status:</strong></td>
</tr>
<tr>
<td><strong>Last tape change:</strong></td>
</tr>
<tr>
<td><strong>Number of bad blocks:</strong></td>
</tr>
<tr>
<td><strong>Percent of tape used:</strong></td>
</tr>
<tr>
<td><strong>Backup sets on tape:</strong></td>
</tr>
</tbody>
</table>

Near the bottom of the window is a box with two columns labeled **Tape Space** and **Data Space**. The Tape Space column indicates tape capacities without data compression. The Data Space column estimates tape capacities with data compression, based upon your history of data compression use. For a new tape, EzTape estimates the tape capacities using level 2 data compression.

**Note:** The entries indicating the space available and used are shown in Kbytes; therefore, the total space on a 80 MB tape is displayed as approximately 80,000 Kbytes.

**Name Tape**

Select this option to assign a **volume name** to the tape currently installed in your tape drive. Once you select this option, you will see the **Name Tape** window:
If the tape already has a name, the name will appear highlighted in the tape name field. Enter a name of up to 31 characters in length.

**Set Tape to Unused**

Select this option if you want to re-use a tape that has already been written to. For example, you might have a full tape which contains an old backup. If you decide you don't need the old backup and you want to re-use the tape to make a new backup, you can set the tape to unused and use it again.

**Caution:** Before using this option, make sure that the tape does not contain information you want to save. Once you set a tape to unused, you can no longer access data that was stored on the tape.

If you have a tape that was written using an EzTape version before 2.0, you must set the tape to unused before you can write to it with the current version of EzTape.

Once you select this option, EzTape will ask you to provide confirmation before proceeding.

Setting a tape to unused takes just a short while. When the operation is complete, the tape is ready for the next backup; you do not need to reinitialize the tape.

**Backup Sets**

This option allows you to:

- obtain a list of backup sets on the current tape
- view information for a backup set
- delete one or more backup sets from the current tape
The figure below shows the **Backup Set List** window:

![Backup Set List Window](image)

**Getting Information about a Backup Set**

To get information about a backup set, select the set from the backup set list and select the **Info** button. If the tape has a password, you will be prompted for the appropriate password. You then see an information window similar to the one below:

![Backup Set Info Window](image)
Deleting Backup Sets

To delete one or more backup sets, select the backup sets in the **Backup Set List** window and select the **Delete** button. You will be asked to confirm that you want the backup sets deleted. If you select the **OK** button, EzTape will delete the backup sets from the tape.

If you’re deleting a backup set that spans more than one tape cartridge, EzTape will prompt you to insert the next tape. If that tape is unavailable, press `[Esc]` to leave the operation. If you have a partial backup set left on a tape, it can be deleted at a later time.

**Caution:** We do not recommend that you restore files from partially-deleted backup sets. If a file in the backup set is split between two tape volumes and one of the volumes has been erased, restoring that file will destroy the original file.

Retension Tape

Select this option to properly tension a tape if you have not used that tape for a long period of time, or if the tape has been exposed to temperature extremes. Once you select this option, the tape will spool from one end to the other, pause, and then spool back. It takes just a short while. This option is not available for Irwin 9000 Series drives.

Initializing a Tape

The **Initialize tape** option formats a blank tape so that it can be used with Irwin AccuTrak Series drives (except for the A850). After you have initialized a tape once, you should never need to initialize that tape again (except if it is bulk-erased). Read the following sections before using the initialize option.

Using Preformatted Tapes

We recommend that you use preformatted tapes, such as the AccuTrak tape you received with your AccuTrak Series tape drive. AccuTrak tapes are ready for use right out of the box. They should never require any kind of initialization. You can obtain additional AccuTrak preformatted tapes from your dealer.
Chapter 11 Using the Tape Utilities

Tip: If, during your first backup with an AccuTrak tape, you receive a message indicating that the media is not servo-written, is not formatted, or is invalid, **do not** initialize the tape. Your problem is most likely an installation problem. Refer to appendix B for troubleshooting information.

**Reusing Tapes**

If you want to reuse a tape that you have used previously to make backups, **do not initialize the tape**. Instead, you should set the tape to an unused state as described earlier in this chapter.

**Using the Initialization Option**

Tip: The initialize option will be grayed out if your tape is already formatted or if you are using a tape drive other than an Irwin AccuTrak Series drive (except for the A850).

Initializing an unformatted tape ties up your system and will take over an hour. If you are running EzTape for Windows, you can switch to other programs while initialization takes place.

Because initialization procedures place precise servo and formatting blocks on a fast-moving tape, occasional formatting errors are not unusual. In the event of an error during formatting, you must bulk erase the tape before attempting to format the tape again.

When you select the **Initialize Tape** option from the **Utilities** menu, EzTape will ask you to confirm that you want to initialize the tape. If you select the **Yes** button, EzTape will initialize the tape.

Once you have confirmed the operation, the only way to stop it is by pulling out the tape. This is not a recommended procedure. Therefore, be sure you want to initialize before selecting this option.

**Ejecting a Tape**

If your tape drive has a power load mechanism for loading a tape, you can use the **Eject tape** option. If there is no tape in your drive, or if your drive doesn't have a power load mechanism (AccuTrak Series drives), this option will be grayed out.
What This Chapter Contains

This chapter shows you how to use options in the View, Window and File menus to:

- determine the order that files are listed in a file window
- determine if the EzTape windows will stack, tile, or cascade
- refresh the screen
- close and open EzTape windows
- hide and show the command ribbon and the status bar
- print out the contents of a window

Determining the Order of Files in a File Window

If you have an open window containing a list of files, you can use the options in the View menu:

<table>
<thead>
<tr>
<th>This option</th>
<th>Sorts the files:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort by name</td>
<td>alphabetically by name</td>
</tr>
<tr>
<td>Sort by date</td>
<td>chronologically by modification date</td>
</tr>
<tr>
<td>Sort by size</td>
<td>by size (large to small)</td>
</tr>
<tr>
<td>Sort by type</td>
<td>alphabetically by the file's extension type (.XXX)</td>
</tr>
</tbody>
</table>
Stacking, Tiling, and Cascading Windows

Use the first three options in the Window menu to organize your window displays.

<table>
<thead>
<tr>
<th>If you select this option:</th>
<th>Then:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stack windows</td>
<td>The Directory Tree window will fill the left half of the main window and the remaining windows will be stacked on top of each other on the right half of the screen, with the active window on top. This is the default setting.</td>
</tr>
<tr>
<td>Tile windows</td>
<td>All open windows will be arranged in a grid pattern. The windows will be placed side-by-side so that they fill the main window. The active window will appear in the upper left corner of the main window.</td>
</tr>
<tr>
<td>Cascade windows</td>
<td>All open windows will be arranged in a cascading pattern. The windows will be placed so that they overlap diagonally across the main window, starting in the upper left corner. The active window will appear in the lower right.</td>
</tr>
</tbody>
</table>

Arranging Window Icons

When you select Arrange icons from the Window menu, EzTape will arrange your file window icons evenly across the bottom of the EzTape program window.

Refreshing Your Window Display

When you select Refresh from the Window menu, EzTape scans your disk drives for any changes made to files or directories since the last update. For example, you may have done a restore, copied files, or moved files. EzTape will then update the contents of the Directory Tree window and any open file windows.
Closing All Directory Windows

When you select Close all directories from the Window menu, EzTape will close all file windows that are currently open.

Automatically Replacing File Windows

When you select Replace on open from the Window menu, every new file window you open will replace the file window that was previously open. A check appears by this option if it is in effect. To turn it off, select the option again and the check will disappear.

Opening/Closing Windows

The Window menu provides the Show directory tree and Show mark rules options for displaying these windows.

When you select one of these options, a check appears by the option and the window opens. To close the window, select the option again and the check will disappear.

The Directory Tree Window

The Directory Tree window lets you list select and mark files on your hard disk, on a tape in your backup drive, or in the EzTape library. For more information on using the Directory Tree window, refer to chapter 6.

The Mark Rules Window

The Mark Rules window provides a list of the rules which represent your currently marked selections. A rule consists of a path specification or mask which identifies the files you have marked. For example, if you choose to backup the directory TEST on hard drive C, you would see this mark rule displayed:

C:\TEST\*.*

The Mark Rules window also allows you to add, edit, or delete mark rules. For more information on using the Mark Rules window, refer to chapter 7.
**Hiding and Showing the Command Ribbon**

The command ribbon provides a means for you to perform commonly-used operations with simple buttons. When you start up EzStart, the ribbon will be visible below the menu bar.

To remove the ribbon, select the **Show ribbon** option and the ribbon will disappear. When you select Show ribbon again, the command ribbon will reappear below the menu bar.

**Hiding and Showing the Status Bar**

The status bar provides a readout which displays the current status of your tape operation. When you start up EzTape, the status bar will appear along the bottom of the EzTape window.

To remove the status bar, select the **Status bar** option and the status bar will disappear. When you select Status bar again, the bar will reappear.

**Using the Open Windows List**

If a window is open, it will be listed at the bottom of the **Window** menu. The currently active window will have a check by it. If you select the name of one of the other open windows, it becomes the active window, and the check will appear by that window.

When you have more than nine windows open, the words **More Windows...** will appear at the end of the window list. Select this option to see a list of all open windows. You may then select one to become active.
Printing with EzTape

The File menu provides options to help you print the contents of an EzTape window.

You use the Print Window option to print the information in the currently selected EzTape window. When you select this option, you will see the following window:

If you choose the Printer option, the information will be sent to your printer. Make sure that the EzTape Printer Setup dialog box is set up and your printer is turned on before using this option.

If you choose the Disk File option, you will see the following dialog box:

Choose the directory and file name where you want to log the information.
Using the Printer Setup Window

When you choose the **Printer Setup** option, you see a window that contains your printer's properties. Make sure that these properties are set correctly before printing.

This window is controlled by your printer driver. The properties in this window will vary, depending on your printer. For more information on setting up this window, refer to your printer documentation.
Setting the Default Options

What This Chapter Contains

This chapter shows you how to use the Options menu to set defaults for:

- EzTape window interactions
- the Backup Parameters window
- the Restore Parameters window
- the dialog boxes for these File menu options: Copy files, Move marked files, Delete marked files, or Change marked files

Setting Window Defaults

When you select the Window defaults option, you will see one of the following dialog boxes:

EzTape for DOS

![Window Defaults dialog box]

- Display short-cuts on startup
- Show ribbon
- Show tape status bar
- Replace window on open
- Sort mode:
  - Sort by file name
  - Sort by file date
  - Sort by file size
  - Sort by file type
- 43/50 line mode
- Use graphic mode
- Save defaults to disk
The table on the following page describes each of the default options you can set.
<table>
<thead>
<tr>
<th>Option:</th>
<th>What it does:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display short-cuts on startup</td>
<td>Opens the Short-cuts dialog box when you start EzTape. This menu will be the first window you see. Check this box if you use the Short Cut options frequently.</td>
</tr>
<tr>
<td>Show ribbon</td>
<td>Displays the command ribbon when you start up EzTape.</td>
</tr>
<tr>
<td>Show tape status bar</td>
<td>Displays the tape status bar when you start up EzTape.</td>
</tr>
<tr>
<td>Replace window on open</td>
<td>When you open a new file window, it will replace the previous file window.</td>
</tr>
<tr>
<td>Sort mode</td>
<td>Determines the order of the contents in a file window. You can choose to list files alphabetically by name, chronologically (by date), by size (large to small), or alphabetically by the files' extension type (.XXX).</td>
</tr>
<tr>
<td>43/50 line</td>
<td>(EzTape for DOS only) Selects a compact screen display. If you have an EGA monitor, you will see 43 lines per screen. If you have a VGA monitor, you will see 50 lines per screen. This option is not available in systems with CGA or monochrome monitors.</td>
</tr>
<tr>
<td>Graphic mode</td>
<td>(EzTape for DOS only) Sets the EzTape display so it makes use of special graphics characters that improve screen appearance. This option is not available for systems with CGA or monochrome monitors.</td>
</tr>
<tr>
<td>Save defaults to disk</td>
<td>Saves the default settings for future sessions. If you do not select this option, these settings will apply only to the current session and will not be saved if you exit EzTape.</td>
</tr>
</tbody>
</table>

Select the **OK** button to accept the new defaults or on the **Cancel** button to return to the EzTape window without changing the defaults.
Chapter 13  Setting the Default Options

Setting Backup Defaults

When you select the **Backup defaults** option, you see the following window dialog box:

![Backup Defaults Dialog Box]

If you are not familiar with the backup parameters, refer to chapter 4.

Choose the **Save defaults to disk** option to save these default settings for future sessions. If you do not select this option, these settings will apply only to the current session and will not be saved if you exit EzTape.

When you are through setting backup parameter defaults, select the **OK** button to accept the new defaults or the **Cancel** button to return to the EzTape window without changing the defaults.

Setting Restore Defaults

When you select the **Restore defaults** option, you see the following dialog box:

![Restore Defaults Dialog Box]
If you are not familiar with the restore parameters, refer to chapter 6.

You can also choose the **Save defaults to disk** option to save these default settings for future sessions. If you do not select this option, these settings will apply only to the current session and will not be saved if you exit EzTape.

When you are through setting restore parameter defaults, select the **OK** button to accept the new defaults or the **Cancel** button to return to the EzTape window without changing the defaults.

### Setting Organize Defaults

When you select the **Organize defaults** option, you see the following dialog box:

![Organize Defaults](image)

These options are defaults for the **Copy files**, **Move marked files**, **Delete marked files**, or **Change marked files** commands in the **File** menu (chapter 6).

The following table describes each of the default options you can set.
### Setting the Default Options

<table>
<thead>
<tr>
<th><strong>Option:</strong></th>
<th><strong>What it does:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Keep tree</td>
<td>Copies the directory tree structure along with the file.</td>
</tr>
<tr>
<td>Confirm on error</td>
<td>When an error occurs during operation, you are notified of the error and given the option to cancel or continue.</td>
</tr>
<tr>
<td>Confirm each file</td>
<td>You will receive a request for confirmation of every file. You will have the option to skip the file, cancel, or continue.</td>
</tr>
<tr>
<td>Remove empty directories</td>
<td>Deletes any marked directories that are empty after the operation is complete.</td>
</tr>
<tr>
<td>Save defaults</td>
<td>Saves these default settings for future sessions. If you do not select this option, these default will apply only to the current session and will not be saved if you exit EzTape.</td>
</tr>
</tbody>
</table>

Select the **OK** button to accept the new defaults or on the **Cancel** button to return to the EzTape window without changing the defaults.
Using EzTape on a Network

What This Appendix Contains

This appendix provides the information you need to use EzTape on a network. You can use EzTape with most popular network operating systems, including Novell NetWare®, NetWare Lite, LANtastic®, 10NET®, IBM PC LAN® and NetBIOS compatible networks.

Before you read this appendix, you should read chapters 2, 4, 5, and 6. These chapters present concepts about the EzTape menu system and file selection that you should be familiar with before proceeding.

General Network Guidelines

This section provides information which applies to all networks that EzTape is compatible with. Later sections in this appendix provide information about specific networks.

To run EzTape on a network, follow these guidelines:

1. Install your tape drive and EzTape on a workstation, not on the server.

2. Use normal file selection processes.

3. If your network uses trustee or access rights, you must have the rights to access those files you intend to backup or restore.

4. If a file is open during backup or restore, EzTape will skip the open file. You can set the backup parameters so that EzTape will inform you when a file is skipped (chapter 4). We recommend that you have users log out during system backup to minimize the occurrence of open files.

5. Note that EzTape will back up special network security files.
Selecting Files for Backup or Restore

When using EzTape on a network, you may see a number of different drive letters listed. Of these drive letters:

- one or more will be your local hard disk(s)
- the others may have the same volume name; in actuality, these are different areas of the network server that you are “mapped” to

You can select files to backup from or restore to any drive that is displayed.

Caution: When performing a restore, pay attention to the directory path in the restore parameters window. The default value is the path of the drive from which the backup set was made. Be sure to change it if necessary. Otherwise, you could restore data to an incorrect drive.

Use normal file selection techniques to include or exclude specific files, as described in chapter 6. EzTape will then back up or restore the files you marked for selection unless either:

- you do not have access rights to a selected file
- the file is in use on the network

In either case, EzTape skips the ineligible files and displays a message.

When the operation is complete, all files chosen will be backed up or restored. Note that backing up multiple and/or large network drives could take more than one tape.
Network-Specific Information

The following sections provide specific information about EzTape-compatible networks.

NetBIOS and DOS Peer-to-Peer Networks

EzTape provides complete support for NetBIOS and DOS peer-to-peer network operating systems. If you are using one of these networks, such as NetWare Lite, LANtastic, 10NET or IBM PC LAN, you can back up and restore your entire network from a workstation running EzTape.

What You Need

In addition to the EzTape system requirements listed in the EzTape Getting Started Manual, you need:

• a network workstation with a tape drive installed

• enough available memory to run EzTape after loading the network operating system

• access rights to the DOS servers or workstations you wish to back up. For example, in a LANtastic environment, you must be logged into each server you wish to back up. You must then assign a unique logical drive designation for each server.

EzTape will display each available server or workstation in the Directory Tree window. Follow the procedures in chapter 4, Backing Up Data from Disk to back them up.
**Novell NetWare Networks**

EzTape provides complete support for networks running under Novell Advanced NetWare software. In addition to being able to back up and restore user files on the network, EzTape can handle special network system files and security information.

**What You Need**

In addition to the EzTape system requirements listed in the *EzTape Getting Started Manual*, you need Novell Advanced NetWare v2.0a or later. You must install the tape drive at a workstation.

**NetWare Work Files**

When you run EzTape, three NetWare files will appear as open files not eligible for backup: DIRSTAMP.SYS, /SYS:/NET$MSG.SYS, and /SYS:/NET$SPL.QUE. These files cannot and need not be included in the backup; they are NetWare work files.

**Bindery Files**

Bindery files are special NetWare files which contain network user information, such as user names, ID numbers, and passwords. Bindery files are not normally available to network users.

When you run EzTape on a NetWare network, it automatically checks to see if you are logged in as the Supervisor. If you are, EzTape enables access to the bindery files; otherwise, it does not.

NetWare version 2.x bindery information is contained in two files, called NET$BIND.SYS and NET$BVAL.SYS. NetWare version 3.x bindery information is contained in three files, called NET$BIND.OBJ, NET$PROP, and NET$VAL. If you select one of these files for backup or restore, the other associated file(s) will be included in the operation. This ensures that you do not accidentally back up or restore only one of a set of bindery files, which could possibly destroy their validity.
**Trustee Rights**

Whenever you use EzTape to back up files from a NetWare network drive, it automatically saves the trustee rights. The trustee rights are assigned at the directory level and specify which network users have access to particular files.

When you perform a restore in the NetWare network environment, you have several options with regard to the trustee rights. You will be prompted to select an option during the restore procedure as part of the restore parameters display. The following table describes these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0      | **Do not restore any of the trustee information.** If you are restoring files to an existing directory for which the correct trustee rights have already been established, choose this option. Similarly, if you are restoring files to a directory for which no trustee rights are desired, choose this option. 

For example, if you are transferring one of your work files from one Novell network to another Novell network, you might choose option 0. The trustee rights already established on each of the networks would remain the same.

If you select option 0 when restoring to a different target, the trustee rights will not be affected since you will not be restoring any trustee information.

| 1      | **Restore trustee information for the directory containing files that have been selected for restore.** If you select option 1 when restoring to a different target and you elect to keep the tree structure, EzTape will recreate the tree under the target directory and restore the trustee rights for the directory containing the files being restored.

If you select option 1 when restoring to a different target and you elect not to keep the tree structure, EzTape will restore the trustee rights for the directory containing the files being restored to the new target directory. |
Option: 2

Description: Restore all trustee information. This type of restore includes the trustee rights as in option 1, but also includes rights associated with directories that are parents to the directory receiving the restored files, up to the root directory. You must have parental rights to the directories being restored.

If you select option 2 when restoring to a different target and elect to keep the tree structure, EzTape will recreate the tree under the new target directory and restore the trustee rights at each level on the tree.

If you select option 2 when restoring to a different target and elect not to keep the tree structure, EzTape will assign the trustee rights for the files being restored to the target directory. All of the rights up the original path will be assigned to the target directory.

The figure below shows an example of restoring trustee rights using Option 1. FILEB and its trustee rights are shown after being restored to the new directory DIRA, both with and without its tree structure.
The following figure shows an example of restoring trustee rights using Option 2. FILEB, its trustee rights, and associated rights are shown after being restored to the new directory DIRA, both with and without its tree structure.

**Maximum Rights**

Maximum rights allow an owner of a directory to set the maximum rights anyone else on the network can have to that particular directory. EzTape saves the maximum rights value during backup and restores it when trustee rights are included in the restore. They follow the same rules under the options for trustee rights.
Troubleshooting

What This Appendix Contains

This appendix shows you what you should do if you experience difficulties while using EzTape.

If you encounter a problem, first read the information below and check the error messages at the end of this appendix. There may be a simple solution to your problem.

If you still need help, call us at one of the numbers listed at the front of the manual. Make sure you have your tape drive model number and serial number available. Also, write down any error messages that occurred to help your technical support representative identify and correct the problem.

Difficulties Recognizing a Preformatted Tape

If, during your first backup with a preformatted tape, you receive a message indicating that your tape is not servo-written, is not formatted, or is invalid, do not initialize the tape. Your problem is most likely one of the following:

1. Make sure you are using the correct type of tape cartridge for your drive.

2. If everything seems to be set correctly, remove and reinsert the tape. It may not have been fully seated.

3. If you are using an external drive, move it away from the monitor or from other devices that give off electromagnetic interference.

4. Turn off your computer completely and then restart. In rare cases, a “stuck bit” may be the problem.
5. If you are using an internal drive, make sure it is installed properly, and all switches and jumpers are properly set. Make sure any additional installation hardware is also properly installed and set.

**Difficulties Reading or Writing a Tape File**

If you experience difficulties while reading from a tape cartridge (restore) or writing to a tape (backup), follow these steps:

1. Try the operation again. The problem may be temporary; for example, a speck of dust or other contaminant may have interfered with the drive reading the tape.

2. If you are using an external drive, move it away from the monitor or from other devices that give off electromagnetic interference.

3. If the problem persists and occurs during backup, use the Retension Tape option under the Option menu to align the tape. If that does not help, use a different tape. If there is no problem with the new tape, you should discontinue use of the old tape.

4. Clean the tape drive's read/write head and capstan, then try the operation again. Refer to your tape drive's installation manual for cleaning information.

5. Turn off your computer completely and then restart. In rare cases, a “stuck bit” may be the problem.

If the problem persists, call your tape drive dealer for assistance.

**Difficulties Initializing an Unformatted Tape**

If you are using an Irwin AccuTrak Series drive (except for the A850) and your tape is unformatted, it must be bulk erased before initialization. You can bulk erase a tape using the Irwin TCE 200, or with an audio/video bulk eraser that you can purchase at most electronic stores. We recommend that you erase both sides of the tape.
Difficulties Reading or Writing a Disk File

If EzTape is unable to read or write a file on your computer's hard disk, check the following:

1. Does the file name, as you typed it, exist in the current or specified directory, on the current or specified disk drive?

2. Is the disk full? If so, remove or delete some files and try again.

3. Are you using the root directory? It may be full. The number of files the root directory can accommodate is limited. Refer to your DOS manual for more information on this limitation. Remove a few files from the root directory and try again.

4. Are you trying to write to a file that is flagged as read-only?

If a Power Failure Occurs

If electrical power is interrupted during a backup or restore operation, simply start over when the power returns. Incomplete data written by the interrupted operation will be replaced by the new operation.

If Your Tape Drive Fails

If your tape drive has problems or fails during operation, refer to your tape drive's installation manual for troubleshooting information. If the problem persists, call your tape drive dealer for assistance.
Appendix B  Troubleshooting

Interpreting Error Messages

When EzTape has trouble executing an operation, it displays an error message to help you diagnose and correct the problem. If you encounter an error message, check the following list to see if there is a solution you can try. If you cannot correct the problem, make a note of the information so that you can discuss the problem with your technical support representative.

General Error Messages

This section describes errors you may encounter when performing backup, restore and utilities operations.

<table>
<thead>
<tr>
<th>Error Message:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data was read, using ECC</td>
<td>The tape media in the cartridge is degrading. You should replace the tape cartridge.</td>
</tr>
<tr>
<td>Data was read, using retries</td>
<td></td>
</tr>
<tr>
<td>Defect spares are all used</td>
<td></td>
</tr>
<tr>
<td>ID CRC or ECC error</td>
<td></td>
</tr>
<tr>
<td>ID was read, using ECC</td>
<td></td>
</tr>
<tr>
<td>Medium positioning error</td>
<td></td>
</tr>
<tr>
<td>Missing data or data addr mark</td>
<td></td>
</tr>
<tr>
<td>Missing ID or ID address mark</td>
<td></td>
</tr>
<tr>
<td>Record not found</td>
<td></td>
</tr>
<tr>
<td>Track following error</td>
<td></td>
</tr>
<tr>
<td>Could not create directory [directoryname]. No files in it will be restored</td>
<td>An error has occurred during a restore operation while creating a directory on the hard disk. There may be an existing file with the same name, or the hard disk might be full. EzTape will skip all of the files in the directory, but will continue the restore.</td>
</tr>
<tr>
<td>Could not create target path</td>
<td>An error has occurred creating the specified path. There may be an existing file with the same name as the target directory, or the disk may be full. EzTape will cancel the restore operation.</td>
</tr>
<tr>
<td>Could not open file [filename] - file not backed up</td>
<td>The user performing the backup does not have access to the files in the directory as determined by the network rights assigned to it. It is also possible that the file is unavailable for backup because it is in use on the network. A rare possibility when neither of these situations applies is a hard failure on the source disk. In all cases, EzTape skips the file and continues the backup.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk is full</td>
<td>There is no more available space on the hard disk. EzTape will cancel the restore.</td>
</tr>
<tr>
<td>Disk mount error</td>
<td>There is not enough memory to perform the operation. EzTape for DOS requires at least 512 KB of available RAM to run. EzTape for Windows requires a minimum of 2 MB of installed RAM to run. If there is not enough memory available, EzTape will cancel the attempted procedure.</td>
</tr>
<tr>
<td>Disk read failure for file [filename] - file not backed up</td>
<td>An error has occurred while reading from the hard disk. EzTape will skip the file, but will continue the backup.</td>
</tr>
<tr>
<td>DMA overrun DMA underrun</td>
<td>There is a problem with your hardware installation.</td>
</tr>
<tr>
<td>Drive not ready</td>
<td>The tape was removed while tape operations were in progress, or there is a problem with the tape. Try the process again. You might also try a different tape.</td>
</tr>
<tr>
<td>Drive select failure</td>
<td>There is a problem with your hardware installation.</td>
</tr>
<tr>
<td>Error opening file [filename]</td>
<td>An error occurred when opening a file on the hard disk during a restore procedure. EzTape will skip the file, but will continue the restore. Try the operation again.</td>
</tr>
<tr>
<td>Error writing tape header</td>
<td>You see this message when a backup fails or the process of setting a tape to unused status fails. This message could be caused by a variety of problems. Try the process again. You might also try a different tape.</td>
</tr>
<tr>
<td>File contents compare error</td>
<td>When performing an optional verify pass, there is a comparison error between the contents of the tape and the hard disk files. EzTape will automatically back up this file again.</td>
</tr>
<tr>
<td>File [filename] has changed - file not verified</td>
<td>On a multi-user system, it is possible for a file to change between the time it is backed up and the time it is verified. If the time, date, or size of the tape and hard disk versions of a file do not match, EzTape will not attempt to verify the file.</td>
</tr>
</tbody>
</table>
## Error Message:

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File [filename] will be re-copied</td>
<td>An error has occurred during the (optional) verification process. There may be an error reading from the tape or there may be an error in the file comparison. EzTape will back up the file again in an attempt to fix the problem.</td>
</tr>
<tr>
<td>File [filename] will not be backed up</td>
<td>An error occurred while reading from the hard disk. EzTape will skip the file and continue the backup.</td>
</tr>
<tr>
<td>File [filename] will NOT be re-copied</td>
<td>An error has occurred while reading from the hard disk during the (optional) verification process. EzTape will not back up the file again, nor will it write over the existing backup set since this may be the only data available.</td>
</tr>
<tr>
<td>Format failure</td>
<td>Initialization has failed. Bulk erase the tape and try again.</td>
</tr>
<tr>
<td>Incompatible cartridge/medium</td>
<td>The tape drive does not support the type of tape cartridge inserted. Confirm that you are using the correct type of tape for your drive.</td>
</tr>
<tr>
<td>Medium was changed</td>
<td>The tape was changed during an operation. Re-install the original tape.</td>
</tr>
<tr>
<td>No index pulses (NOT SERVOED)</td>
<td>If you are using an AccuTrak tape, check your installation. If you are not using an AccuTrak tape, the tape has not been initialized. Initialize the tape using the Initialize option on the Utilities menu.</td>
</tr>
<tr>
<td>No track 0 found (NOT FORMATTED)</td>
<td>The tape is not formatted. Initialize the tape using the Initialize option on the Utilities menu.</td>
</tr>
<tr>
<td>Seek failure for file [filename] - file not backed up</td>
<td>An error occurred while reading from the hard disk. EzTape will skip the file, but will continue the backup.</td>
</tr>
<tr>
<td>Sharing violation</td>
<td>EzTape attempted to back up a file which was in use by another program. The file will be skipped.</td>
</tr>
<tr>
<td>Tape is not formatted</td>
<td>Initialize the tape using the Initialize option on the Utilities menu.</td>
</tr>
<tr>
<td>Tape is not servoed</td>
<td></td>
</tr>
<tr>
<td>Tape is write protected</td>
<td>Remove the tape cartridge and locate its RECORD tab. This is the write protect switch. Push the tab to the left, in the direction of the arrow. Now you can write to the tape.</td>
</tr>
<tr>
<td><strong>Error Message:</strong></td>
<td><strong>Description:</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Tapes are not being restored in order; split file [filename] will not be restored</td>
<td>You will see this message when tapes from a multi-volume backup are being restored out of order and EzTape encounters a file that spans two tapes. EzTape restore the split file, but will restore all other selected files.</td>
</tr>
<tr>
<td>The tape cannot be changed while restoring</td>
<td>After you enter restore selection, EzTape does not allow you to change the tape. To make selections from a different tape, exit restore selection, change the tape, then re-enter restore selection.</td>
</tr>
<tr>
<td>There is no tape drive present</td>
<td>Check to make sure that your tape drive is properly installed and that all cables are securely connected. It is also possible for this message to occur if a tape cartridge is inserted while bringing up EzTape. If this happens, exit EzTape and bring it up again. Make sure that you insert the tape cartridge either before or after, but not during, the loading of the program.</td>
</tr>
<tr>
<td>This tape is too full to begin a backup</td>
<td>The tape is already full (or nearly full). Set the tape to unused, delete backup sets, or use a different tape.</td>
</tr>
<tr>
<td>This tape has been written by [application name]</td>
<td>The tape was used by software other than Irwin EzTape.</td>
</tr>
<tr>
<td>This tape was not written with EzTape</td>
<td>EzTape can only restore tapes written by EzTape version 2.0 and later.</td>
</tr>
<tr>
<td>Verify failure for file [filename]</td>
<td>An error has occurred during the (optional) verification process. There may be an error reading from the tape or hard disk, or there may be an error in the file comparison. EzTape will back up the file again in an attempt to fix the problem, unless the error occurred while reading from the hard disk. In this case, EzTape will not back up the file again, nor will it write over the existing backup set since this may be the only data available.</td>
</tr>
<tr>
<td>Verify has failed. Backup set [backupsetname] will be deleted.</td>
<td>You will see this message when there have been verify errors which were not corrected by performing the backup a second time. EzTape will delete the backup set to avoid the possibility of restoring bad data. You should replace the tape.</td>
</tr>
<tr>
<td>Volume not written with EzTape</td>
<td>You will see this message when attempting to restore a tape which was not written by EzTape. EzTape will cancel the restore.</td>
</tr>
</tbody>
</table>
# NetWare Specific Error Messages

This section describes errors you may encounter when running EzTape on a Novell NetWare network.

<table>
<thead>
<tr>
<th>Error Message:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bindery files may be restored only to Novell drives; the bindery files will not be restored</td>
<td>You have made an attempt to restore NetWare bindery files to a drive that is not a NetWare network drive. EzTape will skip the bindery files, but will continue to restore operation.</td>
</tr>
<tr>
<td>Could not close Novell bindery</td>
<td>An error has occurred in the NetWare function call to close the bindery files. The files must be closed before EzTape can open and read them for backup. There is a problem with the network. EzTape will skip the bindery files and continue with the backup.</td>
</tr>
<tr>
<td>Could not find [filename]</td>
<td>EzTape cannot locate one of the NetWare bindery files in the \SYSTEM directory. There is a problem with the network. EzTape will skip the bindery files and continue with the backup.</td>
</tr>
<tr>
<td>Could not find owner for directory</td>
<td>EzTape received an error when asking the NetWare network shell for the owner of a directory. EzTape will continue the backup, but no trustee information will be recorded for the directory.</td>
</tr>
<tr>
<td>Could not get Novell base for drive [driveletter]</td>
<td>A network error occurred when attempting to restore trustee information for a NetWare directory. EzTape will not restore the trustee information for the directory, but will continue the restore.</td>
</tr>
<tr>
<td>Couldn’t find trustee file</td>
<td>EzTape cannot read the NetWare network trustee information from a tape written by earlier versions of EzTape. EzTape will continue the restore operation, but no trustee information will be restored. Try the operation again. If it fails a second time, attempt the restore using the earlier version of EzTape.</td>
</tr>
<tr>
<td>Error adding trustee [trusteename]</td>
<td>A network error occurred while attempting to add a trustee for a directory which is being restored. EzTape will attempt to restore the other trustees for the directory and will continue the restore.</td>
</tr>
<tr>
<td>Error writing trustee file</td>
<td>A tape error occurred while backing up trustee information for a directory on a NetWare network drive. EzTape will cancel the backup.</td>
</tr>
</tbody>
</table>
### Error Message: Troubleshooting

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tape read error for trustee file</td>
<td>A tape error occurred for the file containing the trustee information for a NetWare directory. EzTape will cancel the restore. Retension the tape and then try the operation again.</td>
</tr>
<tr>
<td>Tape seek error for trustee file</td>
<td></td>
</tr>
<tr>
<td>The bindery files will not be backed up</td>
<td>EzTape cannot locate (or close) the NetWare bindery files in the \SYSTEM directory. There is a problem with the network. EzTape will skip the bindery files and continue with the backup.</td>
</tr>
<tr>
<td>The bindery may be restored by the SUPERVISOR only and to the SYSTEM directory only</td>
<td>You will see this message when attempting to restore the bindery files to a NetWare directory other than the \SYSTEM directory. It also occurs if a user without supervisor rights attempts to restore the bindery files. EzTape will not restore the bindery files, but will continue the restore operation.</td>
</tr>
<tr>
<td>Too many trustees in directory</td>
<td>A directory on a NetWare drive has more trustee information than a buffer can hold. EzTape will continue the backup, but will not record the extra trustee information.</td>
</tr>
<tr>
<td>User [username] does not exist on this net</td>
<td>During restore, one of the trustees for a directory on the tape does not exist on the target NetWare drive. All other trustees are restored, and the restore operation continues.</td>
</tr>
</tbody>
</table>
# Index

## A

- About... 18
- Active window 17
- Adding a Mark Rule 61
- Adding an EzStart event 72
- Adding backup sets to the library 30, 78, 81
- Announce event 74
- Apply Rule window 58
- Archive bit 29, 55, 59
- Arrange icons 92
- Attributes
  - apply rule by 59
  - changing 55
- Automatic start 69

## B

- Backup
  - defaults 100
  - features 1
  - plan 3
  - starting 28
  - status 34
- Backup all files 25
- Backup modified files 25
- Backup Options window 31
- Backup set
  - deleting from library 84
  - deleting from tape 89
  - information 82, 88
  - list 82, 88
  - name 28
- Backup set (cont.)
  - overwrite 29
  - password 29
- Backup Set Parameters window 28
- Bindery files - NetWare 106

## C

- Cascade windows 92
- Changing marked files 55
- Check boxes 13
- Clear all marks 49
- Closing windows 9
- Collapsing the tree 46
- Command buttons
  - dialog box 14
  - help topic 20
- Command field - EzStart 73
- Command ribbon 8
- Commands help 18
- Compression 2, 30
- Control menu icon 9
- Copying marked files 52
- Cross-references 20

## D

- Data compression 2, 30
- Date
  - apply rule by 59
  - dispatch 73
- Defaults 97
- Definitions 20
Delete
- backup sets 84, 89
- EzStart event 74
- Mark Rule 61
- marked files 54
- tapes from library 84
Dialog boxes 12
Directory structure - restoring with 36
Directory Tree window 14, 44, 93
Disk icon 45
Dispatch time and date 73
"Dispatched" 76
Display tape information 85
Drop down list boxes 14

E

- Editing a Mark Rule 61
- Editing an EzStart event 72
- Eject tape 90
- Encryption 30
- Errors - wait for 31, 38
- Error messages
  - general 114
  - NetWare 118
- Excluded files 48
- Expanding the tree 46
- Event
  - adding/editing 72
  - announce 74
  - defined 69
  - deleting 74
  - recurring 73
  - schedule 71
  - suspending 74
- EzStart
  - defined 69
  - for DOS 69, 70, 71, 76
  - for Windows 69, 70, 71, 76

EzStart (cont.)
- loading 70
- opening main window 71
- Options menu 75
EzTape
- defaults 97
- exiting 21
- for DOS 5, 6, 7, 19, 63, 98
- for Windows 5, 6, 7, 19, 62, 97
- overview 1
- main window 8
- menus 10
- starting 7
- Exiting EzTape 21

F

- File management commands 51
- File menu 21, 24, 51, 64, 65, 95
- File selection 14, 44
- File sorting 91
- File type attributes 55, 59, 91
- File overwrite 37
- File window 14, 47

G

- Graphics mode 6
- Getting Started manual 5

H

- Help
  - F1 key 18
  - for DOS 19
  - for Windows 19
  - menu 18
- Hidden files 55, 58
Index

I

IBM PC LAN 105
ID number - tape 79, 83, 86, 88
Index - help 18
Initialize tape 89

K

Keep tree 36
Keyboard help 18
Keys
  file selection 16
  shortcut 11

L

LANtastic 105
Librarian
  adding to 30, 79
  defined 77
  menu 81
  removing tapes from 84
  restoring from 80
  searching 80
  updating 78, 81
  viewing backup set info 81
Library icon 45
List boxes 13
Listing marked files 51
Listing tapes in the library 84
Load parameter file 65
Logging messages 34, 40

M

Mark menu 47, 49, 58
Mark Rules window 60
Mark symbols 47
Marking files and directories
  manually 44
  using apply rule option 57
Mask 59
Maximize button 10
Maximum rights - NetWare 109
Menu bar 8
Menus
  cancelling 11
  choosing menu options 11
  Control Menu 9
  selecting 10
  underlined letter in 10
Message logging 34, 40
Minimize button 10
Modified files backup 25
More Windows... 94
Moving among windows 17
Moving marked files 53

N

Name tape 86
NETbios networks 105
NetWare
  bindery files 106
  error messages 118
  maximum rights 109
  trustee rights 107
  work files 106
NetWare Lite 105
Network rights restore level 38
Networks 103

O

"On Hold" 74
Opening windows 15
Option button 13
Index

Options window
  backup 31
  restore 38
Options menu 97
Organize defaults 101
Overview - EzTape 1
Overwrite backup set 29
Overwrite older files 37

P

Parameter files
  adding as program item 67
  creating 64
  defined 63
  file format 64
  loading 65
  running at command line 66
  saving 64
Password - backup set 29
Power failure 113
Preformatted tape 89, 111
Print window 94
Printer setup 95
Procedures help 18

R

Related topics 20
Read-only files 55, 58
Recurring event 73
Refreshing your display 92
Remarks - backup 28
Removing tapes from library 84
Replace on open 93
Reset archive bits 29
Restore
  defaults 100
  features 1
  (cont.)
    starting 36
    status 41
    using librarian to 80
Restore all files 26
Restore Options window 38
Restore Parameters window 36
Restore to 36
Restore with directory structure 36
Retension tape 89
Reusing tapes 90
Rule
  adding/editing 61
  applying 58
  defined 57
  deleting 61
Running EzTape 7

S

Scan marked files 33, 40, 50
Scheduling an event 71
Scroll bars 10
Searching for files 60, 80
Selecting
  files and directories 16, 47
  media type 45
Set tape to unused 33, 87
Shortcut keys 11
Short-Cuts menu 24
Show
  directory tree 44, 93
  mark rules 57, 93
  ribbon 94
  status bar 94
Sort by 91
Split backup set 25, 26, 32, 39, 41
Stack windows 92
Start backup 28  
Start restore 36  
Starting EzTape 7  
Status bar 9  
Status backup 34  
Status restore 41  
"Sticky" Announcement 76  
Subdirectories 59  
Suspending an event 74  
System files 55, 58  

**T**  
Tape display info 85  
erasing 87  
icon 45  
ID number 79, 83, 86, 88  
initializing 89, 112  
librarian 77  
name 86  
utilities 85  
Tasks menu 28, 36, 50, 51  
Text boxes 13  
Text mode 6  
Tile windows 92  
Time apply rule by 59  
dispatch 73  
Title bar 8  
Tree menu 10, 12, 45, 46  
Troubleshooting 111  
Trustee rights - NetWare 107  

**U**  
Unformatted tapes 90, 112  
Unmarking files 49  
Update library 81  
User defined interval 73, 75  
Using Help command 18  
Utilities menu 85  

**V**  
Verify after backup 29  
View menu 91  
Volume name 86  

**W**  
Wait for errors 31, 38  
Windows border 10  
Window defaults 97  
Window menu 91  

**Misc.**  
10NET 105  
43/50 line mode 99